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About This Guide

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

Best Practice Deployments
To create a production-viable, best practice Filr deployment, complete the sections below in the order 
presented. 

 Chapter 1, “Overview,” on page 9
 Chapter 2, “Planning Is Critical,” on page 11
 Chapter 3, “System Requirements,” on page 13
 Chapter 4, “Setting Up Shared Storage,” on page 23
 Chapter 5, “Downloading and Preparing the Filr Software,” on page 27
 Chapter 6, “Deploying the Virtual Machines,” on page 31
 Chapter 7, “Starting and Configuring the Appliances,” on page 45
 Chapter 8, “Creating an Expandable Filr Deployment,” on page 51
 Chapter 9, “Setting Up Filr Services,” on page 67
 Chapter 12, “Setting Up Sharing,” on page 109

Test and Evaluation Deployments
To create an evaluation or test deployment, see the following sections.

 Appendix B, “All-in-One (Small) Deployment—Creating,” on page 129

and
 Appendix D, “Non-Expandable Deployment—Creating,” on page 133

Upgrade Instructions 
To upgrade existing deployments, see

 Chapter I, “Upgrading Filr,” on page 71
 “Upgrading an All-in-One (Small) Deployment” on page 92

Audience
This guide is intended for Filr Administrators.
About This Guide 7



Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the comment on this topic link at the bottom of each page of 
the online documentation.

Documentation Updates
For the most recent version of this guide, visit the Filr 3 Documentation web site (http://
www.novell.com/documentation/filr-3).

Additional Documentation
For other documentation on Filr 3, see the Filr 3 Documentation web site (http://www.novell.com/
documentation/filr-3).
8 About This Guide

http://www.novell.com/documentation/filr-3
http://www.novell.com/documentation/filr-3


1 1Overview

What Is Micro Focus Filr?
Micro Focus Filr is an enterprise file sharing tool that leverages your current file server and security 
infrastructure to provide multi-device access to organizational and personal files.

For more detail about this illustration and for more illustrations and explanations, see the Filr 3.4: 
Understanding How Filr Works.

What Is “Filr Clustering”?
“Filr clustering” is a term that is sometimes used in the Filr product and means that multiple Filr 
appliances access a shared storage location, which contains deployment-level configuration settings 
and data. “Filr clustering” provides a measure of

 Fault tolerance 

And 
 High availability

“Filr clustering” is not related to Novell Cluster Services. 

This guide refers to “Filr-clustered” deployments as “Expandable” deployments.

eDirectory
Users

Active
Directory

Users

FirewallFilr Access
Devices

My Files

Net Folders

Search

Synchronization

Sharing

Filr

NetWare

Windows

w

OES

SharePoint

Filr Data Disk

Comments

External
Users

Other 
Internal
Users
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2 2Planning Is Critical

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

Creating a successful Filr deployment requires that you 

1. Involve pertinent stakeholders.
2. Conduct a thorough needs assessment.
3. Plan your deployment based on the needs assessment. 

The instructions that follow assume that you have:

1. Completed the planning processes outlined in the Filr 3.4 Planning Your Filr Deployment—Best 
Practices guide.

2. Filled in the Filr Planning Worksheets associated with the Planning Best Practices guide. 
Planning Is Critical 11
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3 3System Requirements

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

Expandable Deployments Are the Focus of This Guide
Other deployment types are covered in 

 Appendix B, “All-in-One (Small) Deployment—Creating,” on page 129
 Appendix D, “Non-Expandable Deployment—Creating,” on page 133.

The following sections outline platform, version, and other requirements for your expandable Filr 
deployment. 

 “Administrative Workstations and Browsers” on page 13
 “Appliance Disk Space” on page 14
 “Appliance Memory and CPU” on page 14
 “Appliance Shared Storage (/vashare Mount Point) Platforms” on page 14
 “Desktop Platforms (for the Desktop Application)” on page 15
 “Desktop Web Application Access” on page 16
 “File Servers (Backend Storage)” on page 17
 “Filr Software” on page 18
 “IP Addresses” on page 18
 “LDAP Directory Services (Users and Groups)” on page 19
 “Mobile Device Platforms” on page 19
 “SQL Database Server” on page 20
 “Virtualization Hypervisor Platform” on page 21

Administrative Workstations and Browsers

Table 3-1   Administrative Workstations and Browsers

Platform Browser Requirement

Windows, Mac, or Linux

Capable of running a listed browser

Mozilla Firefox Latest version

Microsoft Internet Explorer 11

Microsoft Edge Latest version

Chrome Latest version

Safari Latest version
System Requirements 13



Appliance Disk Space
 See Worksheet 25—Storage Planning Summary

Planning for disk space varies widely according to organization needs and the planning process is 
covered in the Filr 3.4 Planning Your Filr Deployment—Best Practices guide. 

General guidelines are summarized in the following sections of the Planning Best Practices guide:

 Filr Appliance Sizing Guidelines
 Filrsearch Appliance Sizing Guidelines
 SQL Server Sizing Guidelines

For an overview of Filr storage, see “Appliance Storage Illustrated” in the Filr 3.4: Understanding How 
Filr Works.

Appliance Shared Storage (/vashare Mount Point) Platforms
 See Worksheet 25—Storage Planning Summary

The Filr appliances in an Expandable deployment access a commonly-shared CIFS or NFS storage 
disk that you will identify and create in Chapter 4, “Setting Up Shared Storage,” on page 23.

Table 3-2   Shared Storage Platforms (/vashare Mount Point)

Appliance Memory and CPU

Table 3-3   Memory and CPU

Protocol Requirement

CIFS  A Windows-based CIFS share

NFS Exported mount point on one of the following:

 SLES 11 SP4

 SLES 12 SP3

NFS on Windows is not supported.

Appliance Recommended Minimum

Filr  12 GB RAM

2 GB Operating System

10 GB Java Heap

 4 CPUs

 8 GB RAM

1.5 GB Operating System

6.5 GB Java Heap

 4 CPUs
14 System Requirements
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Desktop Platforms (for the Desktop Application)
For more information about the Filr desktop application, see the following guides:

 Linux: Filr Desktop Application for Linux Guide  (https://www.novell.com/documentation/filr-3/filr-
desktop-linux/data/bookinfo.html)

 Mac: Filr Desktop Application for Mac  (https://www.novell.com/documentation/filr-3/filr-desktop-
mac/data/bookinfo.html)

 Windows: Filr Desktop Application for Windows Guide  (https://www.novell.com/documentation/
filr-3/filr-desktop/data/bookinfo.html)

Filrsearch Less than 1,000 Users

 8 GB RAM

2 GB Operating System

2 GB Memcached

4 GB Java Heap

 2 CPUs

More than 1,000 Users

 16 GB RAM

2 GB Operating System

3 GB Memcached

8 GB Java Heap

 4 CPUs

Same

MySQL Less than 1,000 Users

 8 GB RAM

 2 CPUs

More than 1,000 Users

 12 GB RAM

 2 CPUs

Same

Appliance Recommended Minimum
System Requirements 15
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Table 3-4   Desktop Platforms (Desktop Application)

Desktop Web Application Access
Three components apply:

 A Browser
 Java
 An Office Application

Table 3-5   Browsers for Web Application Access

Platform Versions

Windows IMPORTANT: Always make sure that the latest patches and support packs are installed.

 Windows 7 SP1 (x86 & x64)

 Windows 10 (x64 only)

Mac IMPORTANT: Always make sure that the latest patches and support packs are installed.

 OS X 10.14 (macOS Mojave)

 OS X10.13 (High Sierra)

 OS X10.12 (macOS Sierra)

Linux Platform  Ubuntu 16.04.4 LTS (Xenial Xerus)

NOTE: Supports Unity graphical desktop environment

 SLED 12 SP3

NOTE:  Filr supports only the default GNOME graphical desktop environment that is 
shipped with SLED 12 SP3.

Platform Requirement

Linux Mozilla Firefox; Google Chrome (latest versions)

Windows Microsoft Edge

Microsoft Internet Explorer 

Mozilla Firefox; Google Chrome (latest versions)

Mac Safari; Mozilla Firefox (latest versions), Google Chrome (latest versions)
16 System Requirements



Table 3-6   Java for Web Application Functionality

Table 3-7   Office Application for Edit-in-Place Functionality

File Servers (Backend Storage)

NOTE: Your organization’s file servers provide the backend storage for Net Folders.

If you use Filr only for user personal storage (My Files), then file servers aren’t required.

Table 3-8   File Servers

Version Functionality

Java v1.7.0 SR4  Editing files with Edit-in-Place as described in 
“Working with files” in the Filr 3.4: User Access 
Guide.

 Uploading folders to Filr as described in 
“Creating a New Folder” in the Filr 3.4: User 
Access Guide.

If the browser does not support HTML 5, 
uploading both files and folders requires this 
version of Java to be installed.

NOTE: OpenOffice and LibreOffice are used synonymously throughout the Micro Focus Filr documentation.

For more information about Edit-in-Place, see “Working with files” in the Filr 3.4: User Access Guide.:

Linux  OpenOffice.org (latest version)

 LibreOffice (latest version)

Windows  LibreOffice (latest version)

 OpenOffice (latest version)

 MS Office 2013

 MS Office 365

Mac  LibreOffice (latest version)

 OpenOffice (latest version)

 MS Office 2011 for MAC

 MS Office 2013 for MAC

 MS Office 365 for MAC

Platform Supported Versions

Windows

(Standalone and 
Clustered environment)

 Windows Server 2016 (CIFS)

 Windows Server 2012 R2 (CIFS)

Windows native DFS-N and DFS-R with replication are supported
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Filr Software
To download and prepare the Filr software, See Chapter 5, “Downloading and Preparing the Filr 
Software,” on page 27.

IP Addresses
Each appliance requires the following.

Table 3-9   IP Addresses

OES

(Standalone and 
Clustered environment)

IMPORTANT: You must apply the latest Scheduled Maintenance Update, otherwise 
the NCP server can fail.

 OES 2018

 OES 2015 SP1 (NCP and CIFS)

 OES 2015 SP1 NSS AD (CIFS)

 DFS and DST for OES are supported

Domain Services for Windows (DSfW) is not supported.

NetWare  NetWare 6.5 SP8

SharePoint  2013

Other In addition to storage that is directly attached to the file servers listed in Net Folders 
can provide access to files that are being stored on any of the following storage 
platforms:

 NetApp NAS device

 EMC

 Other Microsoft Active Directory joined NAS devices that support the CIFS 
protocol. 

 Storage Area Network (SAN)

Component Requirement

IP Address  A static address that is associated with a DNS host name.

Example: 192.168.1.61

Network Mask  The appropriate network mask for the IP address.

Example: 255.255.255.0

Gateway IP Address  The gateway for the IP address subnet.

Example: 192.168.1.254

DNS Host Name  The DNS name associated with the IP address.

Example: filr-1.myorg.local

Platform Supported Versions
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LDAP Directory Services (Users and Groups)

Table 3-10   LDAP Directory Services

Mobile Device Platforms

IMPORTANT: Accessing Filr through a web browser on a mobile device is not supported. Instead, 
download the Filr mobile app that is compatible with your mobile device.

For more information about the Filr mobile app, see the Mobile App Quick Start.

DNS IP Address  Up to three IP addresses of DNS servers for the IP address 
subnet.

Example: 192.168.1.1

NTP IP Address or DNS Name  Up to three IP addresses or DNS names of reliable NTP servers 
used to coordinate time on your organization’s network—
especially your LDAP directory servers.

Example: time.myorg.local

When using VMware, it is recommended that you set up NTP in 
accordance with the VMware best practices guidelines (http://
kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

Directory Service Platform Version

eDirectory  NetIQ eDirectory 9.0.x.x

 NettIQ eDirectory 8.8.x.x

For more information, see the NetIQ eDirectory 8.8 Documentation website 
(http://www.netiq.com/documentation/edir88).

 NetIQ eDirectory version 8.8.x.x on standalone Windows.

IMPORTANT: eDirectory running on Windows servers with file shares is not 
supported.

Active Directory  Windows Server 2016 Active Directory with the latest Service Pack

 Windows Server 2012 R2 Active Directory with the latest Service Pack

Component Requirement
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Table 3-11   Mobile Devices

SQL Database Server

Table 3-12   SQL Database Server

Platform Supported Versions

iOS Phones and Tablets  iOS 11.x and 12.x

The native app is available as a free download in the 
Apple App Store.

Android Phones and Tablets  Android phones and tablets for Android 4.4 or later

The native app is available as a free download in the 
Google Play App Store, the Amazon Appstore for 
Android, and the Samsung Knox Apps store.

Windows Phones

IMPORTANT: Windows tablets are not currently 
supported.

 Windows 8.0 and 8.1

BlackBerry PlayBook and Z10 The native application is available in the BlackBerry World 
app store.

Filr documentation for BlackBerry is the same as for Android 
devices.

Database Type Supported Versions

MySQL  5.6

 5.7

Microsoft SQL  SQL Server 2016 SP1

 SQL Server 2014 SP2

 SQL Server 2012 SP4

 SQL Server 2008 R2 SP4

MariaDB  10.1
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Virtualization Hypervisor Platform

Table 3-13   Virtualization Hypervisor Platform

Hypervisor Type Supported Versions

VMware  One of the following VMware host servers for hosting the appliance VMs.

 ESXi 6.7

 ESXi 6.5 with the latest update

For the most up-to-date compatibility matrix of supported VMware host servers, see 
the VMware Compatibility Guide (http://www.vmware.com/resources/compatibility/
search.php?deviceCategory=software&testConfig=16) provided by VMware. 

 VMware vMotion is supported when running Filr on VMware ESXi 

Hyper-V  The following platforms

 Windows Server 2016

 Windows Server 2012 R2

 Hyper-V Manager to deploy, set up, and configure the appliances.

Xen IMPORTANT: Apply all Xen and kernel patches before installing.

 One of the following servers with the Xen packages installed and the Xen bootloader 
running by default.

 SLES 11 SP4, 64-bit

 SLES 12 SP3, 64-bit

 Virtual Machine Manager to deploy, set up, and configure the appliances.

Citrix Xen  Citrix XenServer 7

 Citrix XenServer 6.5 SP1

 Citrix XenCenter to deploy, set up, and configure the appliances.
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4 4Setting Up Shared Storage

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

 See Worksheet 25—Storage Planning Summary

Figure 4-1 is the first in a series of illustrations that visually track deployment order. 

Figure 4-1   Export an NFS Directory or Create a CIFS share for the /vashare mount point

Complete the instructions in the section below that applies to the plans you have made on Worksheet 
25:

 “Exporting an NFS Directory for the /vashare Mount Point” on page 23

Or 
 “Creating a CIFS Share for the /vashare Mount Point” on page 25

Exporting an NFS Directory for the /vashare Mount Point

IMPORTANT: Filr does not support remote NFS from a Novell Storage Services (NSS) volume.

Filr Search 2

Filr Search 1

SQL Server

Filr 3

Filr 2

Filr 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Set Up NFS or CIFS Shared Storage

.gz.zip Or

download.novell.com
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If you plan to use a CIFS share for Filr shared storage (/vashare) in Worksheet 25, skip to “Creating a 
CIFS Share for the /vashare Mount Point” on page 25. Otherwise, export an NFS directory on a Linux 
server by doing the following:

Table 4-1   Task 1: Exporting an NFS Directory for /vashare

Page, Dialog, or Option Do This

1 - Verify that the server has adequate disk space. 

1. Make sure that the Linux server that you are targeting has the available disk 
space you identified in “Recording Your Plan” in the Filr 3.4 Planning Your Filr 
Deployment—Best Practices guide and recorded on Worksheet 25.

If necessary, add disk space to the Linux server. 

1. On the Linux server, launch YaST2.

YaST Control Center 1. In the Network Services section, click NFS Server.

The NFS Server Configuration dialog box displays.

NFS Server 
Configuration

1. Make sure that the NFS Server is set to Start, that Open Port in Firewall is 
selected (running firewall required for option), and that Enable NFSv4 is not 
selected - i.e. NFS v4 is disabled.

2. Click Next.

Directories to Export 1. Click Add Directory.

YaST2 1. Click Browse and choose the directory or share path identified on Worksheet 
25 that has the required disk space. 

You can add a directory name, such as /shared to the path if desired.

IMPORTANT: The directory path must not be located in the /var directory 
structure on the NFS server, as explained in “NFS Mount Point Must Not Point 
to /var on Target Server” in the Filr 3 Release Notes.

2. Click OK.

As your first Filr appliance is deployed, a directory named filr will be created 
within the directory path you have specified.

3. If you added to the directory path, click Yes to confirm directory creation.

4. Leave the asterisk (*) in the Host Wild Card field.

5. Click the Options field to edit it and change the following options:

 ro to rw (read-only to read-write)

 root_squash to no_root_squash.

6. Click OK.

Directories to Export 1. Click Finish.

2. Skip to Chapter 5, “Downloading and Preparing the Filr Software,” on page 27.
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Creating a CIFS Share for the /vashare Mount Point

Table 4-2   Task 1: Creating a CIFS Share for /vashare

Page, Dialog, or Option Do This

1 - Verify that the Windows server has adequate disk space. 

1. Make sure that the Windows server that you are targeting has the available 
disk space you identified in “Recording Your Plan” in the Filr 3.4 Planning Your 
Filr Deployment—Best Practices guide and recorded on Worksheet 25.

If necessary, add disk space to the server. 

2. Open Windows Explorer

Windows Explorer 1. In Windows Explorer, navigate to the folder that you identified on Planning 
Worksheet 25.

This folder will be the shared storage location (/vashare) for Filr.

2. Right-click the folder, then click Properties.

folder Properties 1. Click the Sharing tab.

2. Click Share. 

Filr Sharing 1. Add a user (new or existing) to the list and assign the Read/Write permission 
to the user.

IMPORTANT: You will need the username and password when you select the 
CIFS share while deploying the Filr appliances.

2. Click Share > Done > Close.

Directories to Export 1. Continue with Chapter 5, “Downloading and Preparing the Filr Software,” on 
page 27.
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5 5Downloading and Preparing the Filr 
Software

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

After planning your deployment and making sure you have the necessary system requirements in 
place, you are ready to download and prepare the Filr software that applies to your virtualization 
platform.

Figure 5-1   Download the Filr Software for your VM platform

 “VMWare” on page 28
 “Hyper-V” on page 28
 “Xen” on page 29
 “Citrix Xen” on page 30

Filr Search 2

Filr Search 1

SQL Server

.gz.zip Or

download.novell.com

Filr 3

Filr 2

Filr 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Download Filr Software
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VMWare
1 As planned in Worksheets 21, 22, and 23 download the Filr software shown below to your 

management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

2 Extract each .ovf.zip file on your management workstation until an ApplianceType-version 
folder appears.

3 Continue with “Deploying a VMware VM” on page 32.

Hyper-V
1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote 

Desktop.
2 As planned in Worksheets 21, 22, and 23 download the Filr software shown below to the location 

where you plan to host your VMs as identified on Planning Worksheet 25.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Extract each .vhd.zip file in the directory where you downloaded it until an ApplianceType-
version.vhd archive file appears.

4 As planned in Worksheets 21, 22, and 23, create a new directory for each virtual machine. 
As a best practice, name these directories with the name that you plan to use for your different 
appliances. 
Consider including information in the names that easily identifies the appliance type and other 
information, such as the IP address.
For example, 
 filr-1-30-192.168.1.61
 filr-2-30-192.168.1.62
 filrsearch-1-30-192.168.1.71
 filrsearch-2-30-192.168.1.72

5 Move the filr-version.vhd archive file to the first Filr appliance-type folder and then copy the 
archive file to the remaining Filr appliance type folders.

Appliance Type Filename

Filr Filr.x86_64-version.ovf.zip
Search Filrsearch.x86_64-version.ovf.zip
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.ovf.zip

Appliance Type Filename

Filr Filr.x86_64-version.vhd.zip
Search Filrsearch.x86_64-version.vhd.zip
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.vhd.zip
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6 Move the filrsearch-version.vhd archive file to the first Filrsearch appliance-type folder and 
then copy the archive file to the second Filrsearch folder.

7 (Optional) If you are deploying a MySQL appliance rather than using an in-house SQL server, 
move the mysql-version.vhd archive file to the MySQL appliance folder.

8 Continue with “Deploying a Hyper-V VM” on page 35.

 Xen
1 Log in to the Xen VM host server either locally or from a remote workstation.

If you are connecting from a remote Linux workstation, use the following command:
ssh -X root@host_ip_address

The -X in the command in required for the GUI installation program upon which the steps in this 
section are based.

2 As planned in Worksheets 21, 22, and 23 download the Filr software shown below to the Xen VM 
host server in the location where you plan to host your VMs as identified on Planning Worksheet 
25.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Untar each *.gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf ApplianceType.x86_64-version.xen.tar.gz
An ApplianceType-version directory is created for each appliance type.

4 Copy and rename the ApplianceType directories until you have one directory for each appliance 
that you have planned to deploy. 
Consider including information in the name that easily identifies the appliance, such as the IP 
address. For example: 

1. Rename the Filr-version directory to Filr-30-192.168.1.61.
2. Copy the Filr-30-192.168.1.61 directory and rename it to Filr-30-192.168.1.62, and 

so on until you have the Correct number of Filr appliances you identified in Worksheet 21.
3. In a similar manner, copy and rename the Filrsearch-version directory until you have 

two Filrsearch appliances.
4. If you need a MySQL appliance, follow the same methodology.

IMPORTANT: Do not change the names of the .raw or .xenconfig files within the directories 
that you have copied and renamed.

5 Continue with “Deploying a Xen VM” on page 38.

Appliance Type Filename

Filr Filr.x86_64-version.xen.tar.gz
Search Filrsearch.x86_64-version.xen.tar.gz
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.xen.tar.gz
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Citrix Xen
1 On a workstation with Citrix XenCenter installed, download the Filr software shown below, as 

planned in Worksheets 21, 22, and 23.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

2 Using a program such as 7-Zip, extract each .xva.tar.gz file on your management workstation 
until an ApplianceType-version folder appears.

3 Continue with “Deploying a Citrix Xen VM” on page 42.

Appliance Type Filename

Filr Filr.x86_64-version.xva.tar.gz
Search Filrsearch.x86_64-version.xva.tar.gz
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.xva.tar.gz
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6 6Deploying the Virtual Machines

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

After downloading and preparing the Filr software as instructed in Chapter 5, “Downloading and 
Preparing the Filr Software,” on page 27, complete the instructions in the section for your 
virtualization platform.

Figure 6-1   Deploy All VMs

 “Deploying a VMware VM” on page 32
 “Deploying a Hyper-V VM” on page 35
 “Deploying a Xen VM” on page 38
 “Deploying a Citrix Xen VM” on page 42

Filr Search 2

Filr Search 1

SQL Server

.gz.zip Or

download.novell.com

Filr 3

Filr 2

Filr 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Deploy All the VMs
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Deploying a VMware VM
Complete the steps in Table 6-1 for each appliance that you planned in the following worksheets:

 Worksheet 21—Filr Appliances
 Worksheet 22—Filrsearch Appliances
 Worksheet 23—SQL Database (if applicable) 

Table 6-1   Deploying a VMware VM

Page, Dialog, or Option Do This

1 - Identifying the appliance. 

1. Referring to the worksheets listed in the introduction, choose an appliance to 
deploy.

IMPORTANT: Your Filr deployment must be set up in the order specified in 
Chapter 8, “Creating an Expandable Filr Deployment,” on page 51.

2. It is recommended to deploy the MySQL appliance behind the firewall.

3. The Search appliance runs Memcached service to enable clustering. To 
secure Memcached, it is strongly recommended to deploy the Search 
appliance behind the firewall. Port 11211 is used by the Memcached service. 

For more information on securing Memcached, see Securing Memcached in 
the Filr 3.4.1: Administrative UI Reference.

2 - Launching the vSphere Client, naming the VM, and choosing the 
datastore. 

vSphere Client 1. On your management workstation, start the vSphere Client.

2. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. For the appliance type you are deploying, navigate to the contents of the 
appropriate folder extracted in Step 2 on page 28.

TIP: Check to be sure that the appliance type matches the worksheet you are 
following. 

2. Select the .ovf file.

3. Click Open.

Deploy OVF Template 1. Click Next > Next.
2. In the Name field, type the name of the appliance as planned on the worksheet 

you are following. For example filr-30-192.168.1.61.

3. Click Next.
4. Choose the datastore you identified as the Location on VM Host Server on 

Worksheet 25—Storage Planning Summary.

5. Click Next to accept the default for the disk format.

6. Do not select Power on after deployment.
7. Click Finish.

The boot disk is created and the appliance is deployed as specified to this 
point.
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3 - Editing the VM settings. 

vSphere Client 1. In the vSphere Client, right-click the VM you just deployed and select Edit 
Settings.

The Virtual Machine Properties dialog displays.

Virtual Machine 
Properties

1. The Filr VMware VMs ship with Memory and CPU settings that are appliance-
type appropriate in most circumstances. 

You can adjust them at this point if desired, or you can adjust them later if 
required for performance tuning purposes.

If you increase or decrease server memory for a Filr or Filrsearch appliance, 
you should also modify the Java heap size, as described in “Changing JVM 
Configuration Settings” in the Filr 3.4.1: Administrative UI Reference.

 4 - Adding and configuring disk 2 (/vastorage) 

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Hard Disk.

2. Click Next.
3. Click Next (create a new virtual disk).

4. Adjust the Disk Size field value specified for disk 2 on this appliance in the 
Worksheet 25—Storage Planning Summary.

5. Under Disk Provisioning, select either: 

 Thick Provision Eager Zeroed
or 

 Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.

6. Under Location, select Specify a datastore or Datastore cluster
7. Click Browse.

8. Select a datastore

9. Click OK.

10. Click Next.
11. Under Virtual Device Node section, select SCSI (1:0).
12. Under Mode, select Independent and Persistent.
13. Click Next.
14. Click Finish.

 5 - Adding and Configuring disk 3 (/var) 

Virtual Machine 
Properties

1. Click Add.

Page, Dialog, or Option Do This
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Add Hardware 1. Select Hard Disk.

2. Click Next.
3. Click Next (create a new virtual disk).

4. Adjust the Disk Size field value specified for disk 3 on this appliance in the 
Worksheet 25—Storage Planning Summary.

5. Under Disk Provisioning, select either: 

 Thick Provision Eager Zeroed
or 

 Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.

6. Under Location, select Specify a datastore or Datastore cluster
7. Click Browse.

8. Select a datastore

9. Click OK.

10. Click Next.
11. Under Virtual Device Node section, select SCSI (2:0).
12. Click Next.
13. Click Finish.

14. If you need to add network adapters, continue with 6 - (Optional) Adding a 
Network Adapter. 

Otherwise, click OK, return to the top of Table 6-1, and deploy the next 
appliance you have planned for.

6 - (Optional) Adding a Network Adapter 

You can add a network adapter if your Filr deployment accesses a separate network 
for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Ethernet Adapter.
2. Click Next.
3. Under Network Connection, select the secondary network associated with 

the Filr installation.

4. Click Next > Finish > OK.

vSphere Client 1. Repeat the steps in this table until all of your planned appliances have been 
deployed, then continue with Chapter 7, “Starting and Configuring the 
Appliances,” on page 45.

Page, Dialog, or Option Do This
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Deploying a Hyper-V VM
Complete the steps in Table 6-2 for each appliance that you planned in the following worksheets:

 Worksheet 21—Filr Appliances
 Worksheet 22—Filrsearch Appliances
 Worksheet 23—SQL Database (if applicable) 

Table 6-2   Deploying a Hyper-V VM

Page, Dialog, or Option Do This

1 - Identifying the appliance. 

1. Referring to the worksheets listed in the introduction, choose an 
appliance to deploy.

IMPORTANT: Your Filr deployment must be set up in the order 
specified in Chapter 8, “Creating an Expandable Filr 
Deployment,” on page 51.

2. It is recommended to deploy the MySQL appliance behind the 
firewall.

3. The Search appliance runs Memcached service to enable 
clustering. To secure Memcached, it is strongly recommended 
to deploy the Search appliance behind the firewall. Port 11211 is 
used by the Memcached service. 

For more information on securing Memcached, see Securing 
Memcached in the Filr 3.4.1: Administrative UI Reference.

2 - Open Hyper-V Manager. 

Hyper-V Host Server 1. Open the Hyper-V Manager.

3 - Create a new VM. 

Hyper-V Manager 1. In the left pane, right-click the server where you have planned to 
create the new virtual machine, then click New > Virtual 
Machine.

The New Virtual Machine Wizard displays.

2. Click Next.

Specify Name and Location 1. Referring to the appropriate appliance worksheet, specify the 
appliance name and select the folder that you created in Step 4 
on page 28.

2. Click Next.

Specify Generation 1. Make sure that Generation 1 is selected. 

2. Click Next.

4 - Specify memory 

Assign Memory 1. In the Startup RAM field, specify the amount of memory (in MB) 
that you planned on the worksheet for this VM. 

2. Click Next.

5 - Assign network adapter 
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Configure Networking 1. On the Configure Networking page, select the networking card 
for this VM.

2. Click Next.

6 - Identify the system disk  

Connect Virtual Hard Disk 1. Select Use an existing virtual hard disk. 

2. Browse to and select the .vhd file in the folder you created for 
this appliance.

3. Click Open.

4. Click Next.

Summary 1. Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

Processor 1. Click Processor.
2. In the Number of virtual processors field, specify the number 

of processors that you planned on the worksheet for this VM. 

3. Click Next.

8 - Add hard disk 2 (/vastorage). 

Settings for VM on Host Server 1. Under Hardware, select IDE Controller 1
2. Click Hard Drive.

3. Click Add.

A Hard Drive entry is added below the controller.

Hard Drive 1. Under Media, select Virtual hard disk.

2. Click New.

New Virtual Hard Disk Wizard 1. Click Next.

Choose Disk Format 1. Select VHD.

2. Click Next.

Choose Disk Type 1. On the Choose Disk Type page, select Fixed size
2. Click Next.

Specify Name and Location 1. Specify the following:

 Name: A descriptive name for the virtual disk. For 
example, Filr-1-Disk-2.

 Location: Specify the location where you want the virtual 
disk to be located. 

2. Click Next.
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Configure Disk 1. Select Create a new blank virtual hard disk.

2. Size: Specify the amount calculated for disk 2 on this appliance 
in the Worksheet 25—Storage Planning Summary.

3. Click Next.

Summary 1. Review the summary information.

2. Click Finish

9 - Add hard disk 3 (/var). 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

Settings for VM on Host Server 1. Under Hardware, select SCSI Controller.
2. Click HardDrive.

3. Click Add.

A Hard Drive entry is added below the controller.

Hard Drive 1. Under Media, select Virtual hard disk.

2. Click New.

New Virtual Hard Disk Wizard 1. Click Next.

Choose Disk Format 1. Select VHD.

2. Click Next.

Choose Disk Type 1. On the Choose Disk Type page, select Fixed size
2. Click Next.

Specify Name and Location 1. Specify the following:

 Name: A descriptive name for the virtual disk. For 
example, Filr-1-Disk-3.

 Location: Specify the location where you want the virtual 
disk to be located. 

2. Click Next.

Configure Disk 1. Select Create a new blank virtual hard disk.

2. Size: Specify the amount calculated for disk 3 on this appliance 
in the Worksheet 25—Storage Planning Summary.

3. Click Next.

Summary 1. Review the summary information.

2. Click Finish > OK
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Deploying a Xen VM
Complete the steps in Table 6-3 for each appliance that you planned in the following worksheets:

 Worksheet 21—Filr Appliances
 Worksheet 22—Filrsearch Appliances
 Worksheet 23—SQL Database (if applicable) 

10 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a 
separate network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with 
Filr.

Hyper-V Manager 1. In Hyper-V Manager, right-click the virtual machine for which 
you want to create an additional NIC, then click Settings.

Settings for VM on Host Server 1. Under Hardware, select Add Hardware.

Add Hardware 1. Click Network Adapter.
2. Click Add.

A Network Adapter entry is added to the hardware list.

Network Adapter 1. Under Virtual Switch, select the secondary network associated 
with the Filr installation.

2. Specify any other required settings for the new network adapter.

3. Click OK.

Hyper-V Manager 1. Repeat the steps in this table until all of your planned 
appliances have been deployed, then continue with Chapter 7, 
“Starting and Configuring the Appliances,” on page 45.
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Table 6-3   Deploying a Xen VM

Page, Dialog, or Option Do This

1 - Before you deploy the first Xen VM. 

1. If you have not already done so, before you begin this process, 
you must set up shared storage for your Filr appliances by 
either: 

 Exporting an NFS directory 

or 

 Creating a CIFS share 

See the “Network-Based Shared Disk Space for /vashare” 
section of Worksheet 25 and complete the instructions in 
Section 4, “Setting Up Shared Storage,” on page 23.

2 - Identifying the appliance. 

1. Referring to the worksheets listed in the introduction, choose an 
appliance to deploy.

IMPORTANT: Your Filr deployment must be set up in the order 
specified in Chapter 8, “Creating an Expandable Filr 
Deployment,” on page 51.

2. It is recommended to deploy the MySQL appliance behind the 
firewall.

3. The Search appliance runs Memcached service to enable 
clustering. To secure Memcached, it is strongly recommended 
to deploy the Search appliance behind the firewall. Port 11211 is 
used by the Memcached service. 

For more information on securing Memcached, see Securing 
Memcached in the Filr 3.4.1: Administrative UI Reference.

3 - Launch the installer. 

Terminal prompt on Xen VM Host 
Server

1. Run the following command to launch the GUI configuration 
menu:

vm-install

The Create a Virtual Machine wizard is displayed.

Create a Virtual Machine 1. Click Forward.

Install an Operating System? 1. Select I have a disk or disk image with an installed 
operating system.

2. Click Forward.

Type of Operating System 1. Select SUSE Linux Enterprise Server 11. 

2. Click Forward.

4 - Name the VM. 

Summary 1. Click Name of Virtual Machine.
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Name of Virtual Machine 1. In the Name field, type the name of one of the appliances that 
you prepared a directory for in Step 4 on page 29.

For example, filr-1-30-192.168.1.61.

2. (Optional) In the Description field, type additional information 
about the appliance.

3. Click Apply.

5 - Specify the RAM and Virtual Processors. 

Summary 1. Click Hardware.

Hardware 1. Change the Initial Memory and Maximum Memory specify the 
amount of memory (in MB) that you planned on the worksheet 
for this VM.

2. Change the Virtual Processors setting to the number that you 
planned on the worksheet for this VM.

3. Click Apply.

6 - Configure the boot disk 

Summary 1. Click Disks.

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Navigate to the contents of the folder for the appliance you are 
creating.

2. Select the .raw file.

3. Click Open.

Virtual Disk 1. Click OK.

7 - Configure disk 2 (/vastorage) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a disk name that reflects the appliance name and that this 
is disk 2. For example, Filr-192.168.1.61-disk-2.

5. Do not change the Storage Format.
6. Change the Size field value according to the appliance type as 

specified in the Worksheet 25—Storage Planning Summary.

7. Make sure that Create Sparse Image File is selected.

8. Click OK.

Page, Dialog, or Option Do This
40 Deploying the Virtual Machines



8 - Configure disk 3 (/var) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a disk name that reflects the appliance name and that this 
is disk 3. For example, Filr-192.168.1.61-disk-3.

5. Do not change the Storage Format.
6. Change the Size field value according to the appliance type as 

specified in the Worksheet 25—Storage Planning Summary.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “9 - 
(Optional) Add a Network Adapter”. 

Otherwise, click OK.

The virtual machine is created, the appliance starts, and the 
configuration process begins.

3. Go to Chapter 7, “Starting and Configuring the Appliances,” on 
page 45.

4. After completing the instructions in Chapter 8, return to Table 6-
3 on page 39 to deploy your next appliance.

9 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a 
separate network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with 
Filr.

Summary 1. Click Network Adapters.

Network Adapters 1. Click New.

Virtual Network Adapter 1. Specify the settings for the adapter.

2. Click Apply.

Network Adapters 1. Click Apply.

Page, Dialog, or Option Do This
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Deploying a Citrix Xen VM
Complete the steps in Table 6-4 for each appliance that you planned in the following worksheets:

 Worksheet 21—Filr Appliances
 Worksheet 22—Filrsearch Appliances
 Worksheet 23—SQL Database (if applicable) 

Table 6-4   Deploying a Citrix Xen VM

Summary 1. Click OK.

The virtual machine is created, the appliance starts, and the 
configuration process begins. 

2. Go to “4 - Accept the license and specify the keyboard layout.” 
on page 46, then return to Table 6-3 on page 39 to deploy your 
next appliance.

Page, Dialog, or Option Do This

Page, Dialog, or Option Do This

1 - Identify the appliance to deploy. 

1. Referring to the worksheets listed in the introduction, choose an appliance to 
deploy.

IMPORTANT: Your Filr deployment must be set up in the order specified in 
Chapter 8, “Creating an Expandable Filr Deployment,” on page 51.

2. It is recommended to deploy the MySQL appliance behind the firewall.

3. The Search appliance runs Memcached service to enable clustering. To 
secure Memcached, it is strongly recommended to deploy the Search 
appliance behind the firewall. Port 11211 is used by the Memcached service. 

For more information on securing Memcached, see Securing Memcached in 
the Filr 3.4.1: Administrative UI Reference.

2 - Launch XenCenter. 

Management 
Workstation

1. Start XenCenter.

XenCenter 1. Connect to the Citrix XenServer where you planned to deploy Filr in Worksheet 
23 - VM Host Servers.

2. Right-click the server and select Import.

3 - Import the system disk 

Locate the File you want 
to import

1. Browse to and select the .xva file on your management workstation for the 
appliance type that you are deploying.

2. Click Open.

3. Click Next.

Select the location where 
the imported VM will be 
placed

1. Select the XenServer.

2. Click Next.
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Select target storage 1. Select the storage repository for the VM.

2. Click Import.

4 - Select the network adapter 

Select network to 
connect VM

1. Select the virtual network adapter.

2. Click Next.

Review the import 
settings

1. Deselect Start VM(s) after import.
2. Click Finish.

IMPORTANT: Depending on network latency and other factors, it can take a 
while to import the system disk.

5 - Specify Memory 

1. If you need to adjust the memory to the amount of memory that you planned on 
the worksheet for this VM, select the newly created VM selected in the left 
pane.

2. Click the Memory tab.

3. Click Edit, change the setting, and click OK. 

6 - Specify Processors 

1. If you need to adjust the CPUs to the number that you planned on the 
worksheet for this VM, right-click the newly created VM in the left pane. 

2. Select Properties.

3. Click CPU, change the setting, and click OK.

7 - Add Disk 2 (/vastorage) 

1. With the newly created VM selected in the left pane, click the Storage tab.

Virtual Disks 1. Click Add....

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 2. For 
example, Filr-1-disk-2.

2. Change the Size field value according to the appliance type as specified in the 
Worksheet 25—Storage Planning Summary.

3. Click Add.

8 - Add Disk 3 (/var) 

Virtual Disks 1. Click Add....

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 3. For 
example, Filr-1-disk-3.

2. Change the Size field value according to the appliance type as specified in the 
Worksheet 25—Storage Planning Summary.

3. Click Add.

Page, Dialog, or Option Do This
Deploying the Virtual Machines 43



9 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a separate network 
for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

1. With the newly created VM selected in the left pane, click the Networking tab.

2. Select the secondary network associated with the Filr installation.. 

XenCenter 1. Repeat the steps in this table until all of your planned appliances have been 
deployed, then continue with Chapter 7, “Starting and Configuring the 
Appliances,” on page 45.
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7 7Starting and Configuring the Appliances

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

After the VMs are deployed with the necessary disks added and other settings adjusted according to 
your plans, it is time to start and configure the appliance software on each appliance. When this step 
is completed, all of the appliances will be running and ready to be deployed as an integrated Filr 
infrastructure.

Figure 7-1   Starting and Configuring the Appliances
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Table 7-1   Starting and Configuring the Appliances

Page, Dialog, or Option Do This

NOTE: For Xen, after you have completed the instructions in “Deploying a Xen VM” 
on page 38, skip to “4 - Accept the license and specify the keyboard layout.” in this 
table.

1 - Before you deploy the first VM. 

1. If you have not already done so, before you begin this process, you must set 
up shared storage for your Filr appliances by either: 

 Exporting an NFS directory 

or 

 Creating a CIFS share 

See the “Network-Based Shared Disk Space for /vashare” section of 
Worksheet 25 and complete the instructions in Section 4, “Setting Up Shared 
Storage,” on page 23 before continuing.

2 - Select an appliance. 

1. Choose one of the appliances that you deployed in Chapter 6, “Deploying the 
Virtual Machines,” on page 31 and refer to its planning worksheet as you start 
and configure it.

IMPORTANT: You must set up your Filr deployment in the order specified in 
Chapter 8, “Creating an Expandable Filr Deployment,” on page 51.

3 - Start the appliance. 

1. After you have downloaded the Filr software and configured your appliances, 
you must start and configure each appliance in turn.

 VMware: In the vSphere Client, power on the first appliance, then click 
the Console tab. 

 Hyper-V: In Hyper-V Manager, right-click the VM and select Start. 

 Citrix Xen: In XenCenter, right-click the appliance and select Start. 

4 - Accept the license and specify the keyboard layout. 

1. After the appliance boots, the License Agreement screen displays.

License Agreement 1. Select your preferred keyboard layout in the Keyboard Language drop-down.

2. (Optional) use the License Language drop-down to change the license 
language.

3. (Optional) use the Keyboard Language drop-down to change the keyboard 
layout.

4. Accept the license agreement.
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Passwords and Time 
Zone

1. On the configuration page, specify the following information:

IMPORTANT: Keep a confidential record of the passwords you set for the root 
and vaadmin users below.

Root password and confirmation: The root password provides root access 
to the appliance terminal prompt. Do not access appliances as the root user 
unless specifically requested by Filr support personnel.

Vaadmin password and confirmation: The preferred user for accessing the 
appliance as requested by Filr support personnel.

Consider using a different password for each appliance for enhanced security.

NTP Server: The IP address or DNS name of the reliable external Network 
Time Protocol (NTP) server for your network. 

Example: time.example.com.

For the best results, set up NTP in accordance with the VMware best practices 
guidelines (http://kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

Region: Your local region.

Time Zone: The time zone of all file servers that Filr will provide access to.

2. Click Next.

Network Settings 1. Specify the following:

Hostname: The fully qualified DNS host name associated with the appliance’s 
static IP address. 

Example: myFilr.mynetwork.example.com.

IP Address: The static IP address for the appliance. 

Example: 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP 
address. 

Example: 255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your Filr virtual 
appliance is located. 

Example: 172.17.2.254.

IMPORTANT: Filr appliances do not tolerate latency and should be installed in 
the same subnet or a near-subnet.

DNS Servers: The IP address of a primary DNS server for your network. 

Example: 172.17.1.1.

Domain Search: The domain that is associated with the Filr host name.

2. Click Next.
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Additional LAN Card 
Configuration

1. (Conditional) If you configured multiple network adapters for this appliance, 
select from the following options, then click Next:

 Do Not Configure: Select this option to configure this network at a later 
time as described in “Changing Network Settings” in the Filr 3.4.1: 
Administrative UI Reference.

 DHCP Dynamic Address: Select this option to have an IP address 
assigned dynamically on the secondary network.

 Statically Assigned IP Address: Select this option to assign a static IP 
address on the secondary network. Then specify the IP address, network 
mask, and host name.

Data Store Location 1. Hard Disk 2 is automatically detected and the disk designation is displayed in 
the hard drive drop-down. 

Accept the defaults for the other options on this page by clicking Next.

WARNING: If you have not already created additional disks 2 and 3 for each of 
your VMs and prepared a shared storage location for your Filr appliances as 
described in early sections of this guide and in Recording Your Plan in the Filr 
3.4 Planning Your Filr Deployment—Best Practices guide, power off the virtual 
machine and make sure you have the required disk space in place for your 
deployment before proceeding. Otherwise, there is a substantial risk that your 
deployment will not meet your organization’s needs.

Data Log Location 1. Hard Disk 3 is automatically detected and the disk designation is displayed in 
the hard drive drop-down. 

Filr: Accept the defaults for the other options on this page by clicking Next.

Filrsearch and MySQL: Accept the defaults for the other options on this page 
by clicking Configure.

Shared Storage Type 
(Filr only)

1. If you are configuring a Filrsearch or MySQL appliance, this page doesn’t 
appear. Go to “Configuring Password, Time, and Network Settings” on 
page 49.

2. If you are configuring a Filr appliance in an expandable deployment (the 
default for this guide)

a. Select the option for the type of shared storage (Remote NFS or Remote 
CIFS) that you identified and configured in Chapter 4, “Setting Up Shared 
Storage,” on page 23.

b. Click Next and continue with the steps for the page matching your 
selection.

3. If you are configuring a small or non-expandable deployment

a. Select Do Not Configure Shared Storage.

b. Click Next.
c. Go to “Configuring Password, Time, and Network Settings” on page 49.
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Shared Storage NFS 
Location

Referring to the work you did in “Exporting an NFS Directory for the /vashare Mount 
Point” on page 23, do the following:

1. For the NFS Server Hostname field, click Browse and select the NFS server 
that you identified.

2. For the Remote Directory field, click Browse and select the directory that you 
exported.

3. Click Configure.

4. Go to “Configuring Password, Time, and Network Settings” on page 49.

Shared Storage CIFS 
Location

Referring to the work you did in “Creating a CIFS Share for the /vashare Mount 
Point” on page 25, do the following:

1. Type the UNC path to the share that you created.

2. Type the user name of the CIFS user that you identified or created.

3. Type the password of the CIFS user.

4. Click Configure.

Configuring Password, 
Time, and Network 
Settings

1. The settings you have specified are configured, storage is verified, and the 
appliance starts. 

Continue as indicated for your deployment type:

Expandable Deployment: Repeat the above steps starting with “2 - Select an 
appliance.” on page 46 until all of your appliances are started, configured, and 
running. Then go to Chapter 8, “Creating an Expandable Filr Deployment,” on 
page 51.

All-in-one (Small) Deployment: Return to Appendix B, “All-in-One (Small) 
Deployment—Creating,” on page 129.

Non-expandable Deployment:  Repeat the above steps starting with “2 - 
Select an appliance.” on page 46 until all of your appliances are started, 
configured, and running. Then return to Appendix D, “Non-Expandable 
Deployment—Creating,” on page 133.
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8 8Creating an Expandable Filr Deployment

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

Figure 8-1 illustrates the general order for deploying Filr components. Letters reference brief 
component/process descriptions in the table that follows. 

The first process (shared storage) was completed in Chapter 4, “Setting Up Shared Storage,” on 
page 23 and illustrated in Figure 4-1 on page 23.

The illustrations that follow are to help you track deployment progress.
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Figure 8-1   Creating an Expandable Deployment

Letter Details
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To create an expandable Filr deployment, complete the following sections in the order presented.

 “Setting Up the SQL Database” on page 53
 “Setting Up Two Filr Search Appliances” on page 56
 “Setting Up the Filr Appliances” on page 57
 “Completing the Expandable Filr Deployment” on page 63
 “Dedicating a Filr Appliance to Indexing and Net Folder Synchronization” on page 65
 “Using the Dedicated Filr Appliance to Complete the Indexing Setup” on page 66

Setting Up the SQL Database
Figure 8-3 illustrates that an SQL database is the second component deployed (after shared storage) 
when creating an expandable Filr deployment.

Filr Software: You download Filr software that you then deploy as a boot/system disk on your VM 
host server.

SQL Database: Each Filr appliance in an expandable deployment accesses the same SQL 
database. If available, an SQL server should be used, but if that is not an option, the MySQL 
appliance can be deployed in its place.

Filrsearch Appliances: Micro Focus best practices require that each Filr cluster be configured with 
two Filrsearch appliances. 

Filr Appliances: By definition, a Filr cluster must contain at least two Filr appliances. Micro Focus 
recommends three Filr appliances with the third appliance dedicated to Net Folder synchronization 
and maintaining the search index. 

Additional Filr Appliances: More Filr appliances can be included as the service load increases. 

Letter Details

B
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F
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Figure 8-2   Set Up an SQL Database 

IMPORTANT: As noted elsewhere, Micro Focus recommends using an existing SQL database if one 
is available. 

If you need to use a MySQL appliance, prepare that now by completing the instructions in 
Appendix C, “MySQL Appliance—Configuring (Alternate Practice),” on page 131 and then continue 
with “Setting Up the Filr Appliances” on page 57.

Prepare your in-house SQL server by completing the steps in one of the following sections: 

 “Configuring a MySQL or MariaDB Server” on page 54
 “Configuring a Microsoft SQL Server” on page 55

Configuring a MySQL or MariaDB Server

IMPORTANT: Do not create the Filr database on your MySQL or MariaDB server manually. 

Let the Filr configuration wizard create the database to ensure the correct configuration.
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Table 8-1   Configuring MySQL or MariaDB for Filr

Configuring a Microsoft SQL Server

IMPORTANT: Do not create the Filr database on your MS SQL server manually. 

Let the Filr configuration wizard create the database to ensure the correct configuration.

Table 8-2   Configuring Microsoft SQL Server for Filr

File Do This

1 - Edit the configuration file. 

MySQL or MariaDB 
server > /etc/my.cnf 
file

1. Edit the file as follows:

[client] 
default-character-set = utf8

[mysqld]
character-set-server = utf8
max_connections = 900
transaction-isolation = READ-COMMITTED
expire_logs_days = 7

The expire_logs_days setting is optional, but is recommended because it 
cleans up mysql-bin-* files. 

Unless this is done regularly, the files will consume significant disk space in the 
vastorage directory.

2. Uncomment the InnoDB tables section. 

3. Increase the buffer pool size to approximately 60 percent of the amount of 
RAM that has been allocated to the dedicated server. 

For example, a dedicated server with 4 GB of RAM should have a buffer pool 
size of 2560 MB, as follows:

innodb_buffer_pool_size = 2560M

4. Identify or create a user account with sufficient rights to create and manage the 
Filr database.

Worksheet 23 1. Record the username and password on Worksheet 23.

2. Continue with “Setting Up Two Filr Search Appliances” on page 56.

File Do This

1 - Configure the server. 

Server management 
console

1. Enable remote access to the Microsoft SQL database server.

2. Open port 1433 on the Windows firewall where the database server is running.

3. Identify or create a user account that is configured with SQL Server 
Authentication and has sufficient rights to create and manage the Filr 
database.

IMPORTANT: Filr supports only SQL Server Authentication. Windows 
Authentication and Windows Domain User Authentication to Microsoft SQL are 
not supported.
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Setting Up Two Filr Search Appliances
Filr best practices require that every expandable deployment have two Filrsearch appliances. There 
are no advantages to having more than two.

Best practices allow for operating Filr with one search appliance, but only under special 
circumstances, such as when reindexing is required. One appliance continues to service user 
requests while the other is focused on rebuilding the search index.

Figure 8-3 shows that two Filr Search appliances are the third and fourth components deployed in an 
expandable deployment.

Figure 8-3   Set up Two Filr Search Appliances

Worksheet 23 1. Record the username and password on Worksheet 23.

Server management 
console

1. Run the following queries against the database:

ALTER DATABASE database-name SET READ_COMMITTED_SNAPSHOT ON         
ALTER DATABASE database-name COLLATE Latin1_General_CI_AS_KS_WS 

2. Continue with “Setting Up Two Filr Search Appliances” on page 56.

File Do This
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Filr Search 1
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SQL Server

.gz.zip Or

download.novell.com

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances
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Table 8-3   Setting Up the Filrsearch Appliances

Setting Up the Filr Appliances
Figure 8-4 illustrates that the Filr appliances are deployed after all other components are in place. 

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 9443 Administration Utility on the first Filrsearch appliance using the 
following URL:

https://filrsearch_IP_Address:9443

Where IP_Address is the IP address of the first Filrsearch appliance.

Filr Search Appliance 
Sign In

1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 47.

Filr Search Tools
1. Click the Configuration button  to launch the Filr Search Configuration 

Wizard. 

Filr Search Configuration 
Wizard

1. Click Next.
2. Type and confirm a password for the Lucene Service User (use the same 

password for both appliances).

Make a note of the password for later.

3. Click Finish.

Search Settings 1. Scroll down and click Submit > OK.

1. Repeat the steps in this table for the second Filrsearch appliance, then close 
the browser.

2. Continue with “Setting Up the Filr Appliances” on page 57
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Figure 8-4   The Filr Appliances Are Set Up Last

Table 8-4   Logging in and Starting the Configuration Wizard

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 9443 Administration Utility on the first Filr appliance using the 
following URL:

https://filr_IP_Address:9443

Where IP_Address is the IP address of the first Filr appliance.

Filr Appliance Sign In 1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 47.

Filr Appliance Tools
1. Click the Configuration icon  to launch the Filr Configuration Wizard. 

Filr Configuration Wizard 1. Large Deployment is automatically selected.

Click Next. 
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Figure 8-5   Each Filr Appliance Needs the Database Connection Information
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Table 8-5   Configuring each Filr to connect to the SQL Database

Page, Dialog, or Option Do This

Database 1. Specify the following configuration options for the database:

Database Type: Select the type of database that you prepared in “Setting Up 
the SQL Database” on page 53.

Host Name: The host name or IP address of the database server.

Port: The wizard selects the standard port for the database type. If your server 
communicates using a non-standard port, adjust the number accordingly

Database Name: The name of the database you want the wizard to create 
(first appliance) and then connect to (subsequent appliances).

User Name: The administrative user name you identified in “Setting Up the 
SQL Database” on page 53. 

For the MySQL appliance, the default is filr. 

Password: The administrative user’s password.

2. Click Next.
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Figure 8-6   Initially, Each Filr Appliance Is Configured to Work with One Filr Search Appliance
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Table 8-6   Specify the First Search Appliance, Locale, and Admin user

Page, Dialog, or Option Do This

Search Appliance 1. Specify the first Filrsearch appliance’s DNS name and Lucene password, then 
click Finish.

IMPORTANT: If you specify the IP address, it must be resolvable to the DNS 
hostname of the search appliance.

2. Click Next.

Default Locale 1. Select a Default Locale.

2. If desired, specify a name other than admin for appliance administration on 
port 8443.

3. Click Finish.

IMPORTANT: Wait for the appliance to start before closing the tab or 
navigating away from the page.

4. When the “Congratulations!” message displays, return to Table 8-4 and deploy 
the next Filr appliance.

5. After all of the Filr appliances are deployed, continue with “Completing the 
Expandable Filr Deployment.”
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Completing the Expandable Filr Deployment
Figure 8-7   When One Filr Appliance Is Configured for “Filr Clustering,” All of Them Are
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Enabling Filr-based Clustering
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Table 8-7   Enabling Filr-based Clustering

Figure 8-8   The Filr Appliances Are Individually Configured to Use Both Filrsearch Appliances

Page, Dialog, or Option Do This

Configuration Summary 1. In the Configuration panel, click Clustering.

Clustering 1. Select Enable Clustered Environment.
2. The JVM Route field is used only if you are setting up Apache load balancing, 

and is used to uniquely identify this appliance. In many cases, the hostname 
(automatically supplied) will suffice, but you can customize it if needed.

3. In the Server Address field, make sure that both Filrsearch appliances in your 
deployment are listed. Separate the appliances with a space. Use either IP 
addresses or fully-qualified hostnames to identify the appliances.

4. Click OK.

5. Click Reconfigure Filr Server.
The Filr appliance is reconfigured and restarted.

Subsequently, the configuration is shared by each Filr appliance through the /
vashare mount point.
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Table 8-8   Configuring High-availability Searching

Dedicating a Filr Appliance to Indexing and Net Folder 
Synchronization

As a best practice, Micro Focus recommends dedicating one Filr appliance to Indexing and Net 
Folder Synchronization, which are very resource-intensive tasks.

Do the following:

 Allow Net Folder Synchronization on only the dedicated appliance: Disable Net Folder 
Synchronization on all other Filr appliances as follows:

1. Access the Port 9443 administration console.
2. Click Net Folders.
3. De-select Allow Synchronization.
4. Repeat on all other Filr appliances except the one you are dedicating to Net Folder 

Synchronization.
Now when a Full synchronization occurs (either as a result of a scheduled or manual 
synchronization), the Filr appliance that you set aside is the one that handles the load. 

NOTE: Just-in-time synchronization (JITS) is unaffected and takes place on whichever Filr 
appliance receives the user request that triggers JITS.

Page, Dialog, or Option Do This

Configuration Summary 1. In the Configuration panel, click Search Appliance.

Search Appliance 1. Click the Configuration Type drop-down list and select High Availability.

2. Type the Lucene service password that you set in Table 8-3 on page 57.

3. Notice that the Filrsearch appliance you configured for this Filr appliance is 
listed under Name. 

Click Add.

New Search Node 1. In the Name: field, type an arbitrary name for the second appliance.

2. In the Host Name: field, type the DNS host name of the other Filrsearch 
appliance.

3. Click OK.

Search Appliance 1. Click OK.

Configuration 1. Click Reconfigure Filr Server.

The appliance is reconfigured and restarted.

However, in contrast with the process in Table 8-7, the Search Appliance 
configuration is not propagated to the other Filr appliances.

2. In the upper-right corner, click Log out.

1. Log in to the next Filr appliance and repeat the steps in this table.

2. When all of the Filr appliances have been configured for high-availability 
searching, continue with Dedicating a Filr Appliance to Indexing and Net 
Folder Synchronization.
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 Use Load Balancing to isolate the dedicated appliance from user requests: When you set 
up load balancing, don’t include the dedicated Filr appliance in the round-robin rotation. 

 Rebuild the search index using the dedicated appliance:  Follow the steps in the next 
section. 
Thereafter, the dedicated appliance will handle all of the re-indexing workload.

Using the Dedicated Filr Appliance to Complete the 
Indexing Setup 

Table 8-9   Index with the Dedicated Appliance

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 8443 Administration Utility on the Dedicated Filr Appliance using the 
following URL:

https://dedicated_filr_IP_Address:8443

Where IP_Address is the IP address of the dedicated Filr appliance.

Filr 3.0 Sign In Dialog 1. Log in as user admin with password admin, or with the alternate administrator 
name/password if you specified one for this appliance in Table 8-6 on page 62.

2. When prompted, change the user password.

Product Improvement 
(first login only)

1. Click OK.

Filr Main Window (Web 
access)

1. Click the Admin user name in the upper-right corner.

2. Select Administration Console.

Administration Console 1. Click Index in the left frame.

Search Index 1. Select Re-Index Everything.

2. Under Select the Nodes to Apply Re-Indexing to, select the second, write-
only Filrsearch appliance.

3. Click OK.

Indexing should complete with no errors.

Indexing has finished! 1. Click Close.

Administration Console 1. Click Nodes in the left frame.

Search Nodes 1. Change the User Mode Access option for the second Filrsearch appliance to 
Read and Write.

2. Click Apply > Close.

the dedicated Filr appliance will now handle all of the re-indexing workload.
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9 9Setting Up Filr Services

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

Complete the following steps to prepare your Filr site and make it available to users.

1 Using the Port 9443 > License dialog, install the same valid license on each Filr appliance in 
your system. 

2 Referring to the Worksheets indicated below, change any Filr infrastructure configuration 
settings that require restarting Filr. 
This prevents interrupting Filr services after users begin accessing Filr services.

3 Referring to the worksheets below, add users and groups to your Filr site and set up the LDAP 
synchronization processes.

Worksheet 13 - Notifications 1. (Optional) Using the Port 9443 > Configuration > 
Outbound E-mail dialog, configure your system for 
integration with an external email system.

2. Using the Port 8443 > System > E-Mail dialog, review the 
default notification settings and make any required 
configuration changes. 

Worksheet 20 - Networking Support 1. Review the settings in the Port 9443 > Firewall dialog and 
make sure that the port and firewall settings on your 
network are configured to support Filr services. 

2. If you are enabling port redirection so that users don’t 
need to include :8443 in Filr requests, configure that now.

Path: Port 9443 Appliance Console > Configuration > 
Network

3. If you are using NetIQ Access Manager. 

Path: Port 9443 Appliance Console > Configuration > 
Reverse Proxy
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4 If you want users to be able to share through Filr, you must enable sharing for the Filr system. 

5 if you want users to be able to upload personal files and folders directly to the Filr site, you must 
enable personal storage.

For more information about personal storage, as well as how personal storage relates to users’ 
Home folders, see “Enabling Personal Storage for Users and Groups” in the Filr 3.4.1: 
Administrative UI Reference.

6 Configure Home Net Folder servers.

If the search context of your LDAP synchronization contains an OES or Windows server that has 
a Home folder attribute associated with at least one user, a Net Folder Server is ready to be 
configured immediately after running the LDAP synchronization process. You need to consider 
the amount of data in users’ Home folder directories when performing an LDAP synchronization. 

Worksheet 4 - Users and Groups (LDAP 
and Non)

1. Configure your Filr system to connect to an existing 
LDAP source, such as eDirectory or Active Directory, to 
control user access to the system. 

Path: Port 8443 Filr Admin Console > System > LDAP
2. Manually create any non-LDAP users and groups that 

need access to Filr services.

For more information, see “Filr Admin Created Users and 
Groups:” in Filr 3.4: Understanding How Filr Works and 
“the New User button” in the Filr 3.4.1: Administrative UI 
Reference.

Worksheet 5 - LDAP Synchronization 1. Configure the Filr system to synchronize with your LDAP 
servers.

For assistance, see “LDAP Servers and Synchronization” 
in the Filr 3.4.1: Administrative UI Reference.

Worksheet 14 - System-Level Sharing 
Settings

1. Configure the system-level share settings. 

For more information about allowing users to share 
documents within Filr, see “Managing Sharing, License 
Terms, and Comments” in the Filr 3.4.1: Administrative UI 
Reference.

Worksheet 11 - Personal Storage 1. Configure Personal Storage.

For more information about allowing users to share 
documents within Filr, see “Enabling Personal Storage for 
Users and Groups” in the Filr 3.4.1: Administrative UI 
Reference.

Worksheet 8 - Net Folder Servers 1. Configure Home Net Folder servers.

For more information, see “Creating and Managing Net 
Folder Servers” in the Filr 3.4.1: Administrative UI 
Reference.
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The following points are critical to successful Home NF Server creation and the synchronization 
of access privileges.
 Import Both Groups and Users: If you import only LDAP users and not the groups they 

belong to, then file system group permissions won't map to Filr group permissions when Net 
Folders are created. 

 Register User Profiles Automatically (default): If you deselect this option, then users 
won't be created until after they log in. This causes the following issues:
 You must wait until users log in to their home folders before you can configure the 

proxy users and passwords for any HOME Net Folder Servers.
 Net Folder access permissions that key off user-based file system permissions will not 

be set or updated during Net Folder Synchronizations.
 Register Group Profiles Automatically (default): If you deselect this option, groups will 

not be created and Net Folder access permissions that key off group-based file system 
permissions will not be set or updated during Net Folder Synchronizations.

7 Configure Net Folder Servers.

8 Configure Net Folders. 

Net Folders in Filr provide access to files on your corporate OES, Windows, or NetWare file 
servers by synchronizing file metadata. In essence, a Net Folder is simply a pointer or a 
reference to a specific folder on a specific file server. 
Filr can be configured to index the content of Net Folders to make the content searchable.
For more information about Net Folders, see “Managing Net Folders” the Filr 3.4.1: 
Administrative UI Reference.

9 Enable additional Filr Users for Administrative Access.

10 (Optional) Allow access to the Filr site through NetIQ Access Manager.

Worksheet 8 - Net Folder Servers

Worksheet 10 - Home Folder Net Folder 
Servers

Worksheet 17 - Net Folder Server 
Synchronization

1. Configure the other Net Folder servers that are identified 
on the worksheet.

For more information, see “Creating and Managing Net 
Folder Servers” in the Filr 3.4.1: Administrative UI 
Reference.

Worksheet 9 - Net Folders

Worksheet 15 - Net Folder Sharing 
Settings

Worksheet 16 - Net Folder Global 
Settings

Worksheet 18 - Net Folder 
Synchronization

1. Configure the Net Folders that are identified on the 
worksheet.

For more information, see “Managing Net Folders” in the 
Filr 3.4.1: Administrative UI Reference.

Worksheet 19 - Administrative Access 1. Configure users for administrative access to Filr.

For more information, see “Assigning and Managing Port 
8443 Direct Administrators” in the Filr 3.4.1: 
Administrative UI Reference.
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For more information about using NetIQ Access Manager with Filr, see Chapter A, “Access 
Manager (NAM) and Filr Integration,” on page 121.

IMPORTANT: When you use NetIQ Access Manager with Filr, external users cannot access 
your Filr site. This means that the following features are not functional:
 Users are not able to share with external users, as described in “Sharing with People 

Outside Your Organization” in the Filr 3.4: User Access Guide.
 Users cannot make items accessible to the public, as described in “Making Files Accessible 

to the Public” in the Filr 3.4: User Access Guide.
This means that public users cannot access the Filr site as the Guest user. For more 
information about the Guest user, see “Guest Users:” in Filr 3.4: Understanding How Filr 
Works.

For more information about external users in Filr, see “External, Self-Provisioned Users:” in Filr 
3.4: Understanding How Filr Works.

11 Configure mobile device access to the Filr site, as described in “Mobile Device Access—Default 
Settings” in the Filr 3.4.1: Administrative UI Reference.

12 Configure the Filr desktop application to access files from the Filr site.
For more information about configuring the Filr desktop application, see “Desktop Access—
Default Settings” in the Filr 3.4.1: Administrative UI Reference.

IMPORTANT: For optimal performance of the Filr system when using the Filr desktop 
application, consider the following: 
 Users should not configure the Filr desktop application to synchronize more than 1,000 total 

files, or to synchronize individual files that are larger than 1 GB to their workstations. For 
information about how users can configure the Filr desktop application to synchronize files 
to their workstations, see the Micro Focus Filr 3.0 Desktop Application Guide for Windows 
(https://www.novell.com/documentation/filr-3/filr-desktop/data/bookinfo.html) and the Micro 
Focus Filr 3.0 Desktop Application Guide for Mac (https://www.novell.com/documentation/
filr-3/filr-desktop-mac/data/bookinfo.html).

13 Configure Filr to support WebDAV on a Windows 7 environment, as described in “WebDAV 
Support” in the Filr 3.4: Maintenance Best Practices Guide.

14 If your Filr site needs to support multiple languages, configure the site as described in “UI 
Language” in the Filr 3.4.1: Administrative UI Reference.

15 After you have completed all of the topics in this list that are relevant to your Filr environment, 
you can invite users to use the Filr site. For information about how to use the Filr site, see Filr 
3.4: User Access Guide.
70 Setting Up Filr Services

https://www.novell.com/documentation/filr-3/filr-desktop/data/bookinfo.html
https://www.novell.com/documentation/filr-3/filr-desktop-mac/data/bookinfo.html
https://www.novell.com/documentation/filr-3/filr-desktop-mac/data/bookinfo.html
https://www.novell.com/documentation/filr-3/pdfdoc/filr-bp-maint/filr-bp-maint.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#b11v1e8b
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#b11v1e8b
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#b11z77gg
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#b11z77gg
https://www.novell.com/documentation/filr-3/pdfdoc/filr-overvw/filr-overvw.pdf#guestuserabout
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-overvw/filr-overvw.pdf#b1cnjp3t
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#language
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#language
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#mobilesite
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#mobilesite
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#desktopapp
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#desktopapp
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-bp-maint/filr-bp-maint.pdf#br2qg1d
https://www.novell.com/documentation/filr-3/pdfdoc/filr-bp-maint/filr-bp-maint.pdf#br2qg1d
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-overvw/filr-overvw.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-overvw/filr-overvw.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-overvw/filr-overvw.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-overvw/filr-overvw.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-user-access/filr-user-access.pdf#bookinfo
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#bookinfo


I IUpgrading Filr

You can upgrade your Filr setup from Filr 2.0 to Filr 3.0. However, Filr 3.x releases are only available 
as online updates to Filr 3.0 or later.

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

 Chapter 10, “Upgrading from Filr 2.0 to Filr 3.0,” on page 73
 Chapter 11, “Updating to Filr 3.4,” on page 107
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10 10Upgrading from Filr 2.0 to Filr 3.0

Review the following sections before you upgrade your Filr 2.0 setup to Filr 3.0:

 “Upgrading a Large Filr Deployment” on page 73
 “Upgrading an All-in-One (Small) Deployment” on page 92

Upgrading a Large Filr Deployment
Before upgrading a Filr deployment, you must ensure certain requirements are met. See “Before You 
Upgrade!” on page 73 and then complete the instructions in the following sections in order:

 “Understanding the Appliance Upgrade Process” on page 76
 “Downloading and Preparing Software for the Upgrades” on page 77
 “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80
 “Upgrading the VMs” on page 81
 “Deploying the Upgraded (Replacement) VMs” on page 90
 “Performing Post-Upgrade Tasks” on page 91

Before You Upgrade!
Failure to comply with the following critical points could result in a non-functional Filr system.

NOTE: As an additional resource to the information in this section, TID 7017288 has a “Pre-Flight 
Checklist” that can help you ensure a successful upgrade.

Critical Point Details

 Review the Release 
Notes

 Check “Upgrade Notes” and “Upgrade” known issues in the Filr 3 Release 
Notes before you start the upgrade process.
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 Plan the upgrade order 
and follow it.

 You must upgrade the appliances in order of dependency upon each other.

1. Shut Down Order:  Prepare a list of your appliances that defines the 
correct shut down order: 

 Filr: All Filr appliances must be shut down first.

 Filrsearch: Next, you shut down the Filrsearch appliances.

 MySQL (if applicable): Finally, if you are using a MySQL 
appliance instead of an in-house SQL server, you shut it down 
last.

2. Deployment Order: Prepare a second list of that defines the correct 
upgrade and deployment order: 

 MySQL (if applicable): If you are using a MySQL appliance 
instead of an in-house SQL server, you must upgrade and 
deploy that appliance first.

 Filrsearch: You must upgrade and deploy the Filrsearch 
appliances before the Filr appliances.

 Filr: When the upgraded MySQL and Filrsearch appliances are 
up and running, upgrade and deploy the first Filr appliance. 
Then upgrade and deploy the additional Filr appliances.

3. If there are things you need to remember about individual appliances, 
include those reminders in the appropriate list.

4. Use the shut down list as you complete the steps in “Upgrading the 
VMs.”

5. Use the upgrade list as you complete the steps in “Deploying the 
Upgraded (Replacement) VMs.”

 Ensure that the VM 
host has enough 
unformatted disk space.

 The VM host server must have enough unallocated disk space to contain 
the following disks for each appliance. This is only temporary because after 
the upgrade completes, old appliances can be deleted and their disk space 
reclaimed. 

 System Disk (/): This is created automatically as you deploy the 
downloaded software. 

Size is 20 GB per appliance.

 Disk 2 (/vastorage): You make a copy of each old appliance’s Disk 
2.

Size needed equals the total size of all disks to be copied.

 Each Disk 3 (/var): You create this disk for each appliance in 
conjunction with the upgrade process.

Size recommendation for Filr 3 is 4 GB plus 3 times the RAM 
allocation for each appliance being upgraded.

NOTE: The existing /vashare mount point is used by the upgraded Filr 
appliances. No new disk space is required for upgrading.

 Make sure that existing 
appliances are running 
version 2.0.

 Make sure that all appliances are running version 2.0 with the latest 
patches applied.

See “Managing Field Test Patches” in the Filr 2.0: Administration Guide.

 Version 1.2 appliances must first be upgraded to version 2.0.

See “Upgrading Filr” in the Filr 2.0: Installation and Configuration Guide.

Critical Point Details
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 Remove all VMware 
Snapshots

 Before copying Disk 2, make sure to remove all VMware snapshots so that 
the /vastorage disk has the correct disk file and latest configuration 
settings.

 Make sure that 
upgraded appliances 
meet Filr 3.0 system 
requirements.

 See Chapter 3, “System Requirements,” on page 13.

 RAM and CPU requirements are summarized in the following sections of 
the Planning Best Practices guide:

 Filr Appliance Sizing Guidelines

 Filrsearch Appliance Sizing Guidelines

 SQL Server Sizing Guidelines

 Do not attempt 
unsupported path 
migrations.

 No Cross-platform: You cannot upgrade from one virtualization platform 
to another. You can only upgrade VMware to VMware, and so forth.

 No Mixed Versions: All of the Filr and Filrsearch appliances in an 
expandable deployment must be upgraded to the same version. 

 No Cross-Deployment-Types: You can only upgrade small to small, non-
expandable to non-expandable, or expandable to expandable. 

If you have a small or non-expandable deployment, and you need an 
expandable deployment, you must either install a new system or contact 
Micro Focus Consulting (http://www.novell.com/consulting) to assist you 
with the migration.

 Prepare appliances 
with two network 
adapters before 
upgrading.

 For any appliances with two network adapters, do the following:

1. Download the networkprep.zip file from the Filr software 
downloads page.

2. Enable SSH on the appliance, as described in “Managing System 
Services” in the Filr 3.4.1: Administrative UI Reference.

3. Using an SSH client (such as WinSCP), log in to the appliance as the 
root user.

4. Copy the networkprep.zip file that you downloaded to the /root/ 
directory on the appliance.

5. Unzip the networkprep.zip file:

unzip networkprep.zip
The networkprep folder is created.

6. Change to the network prep folder:

cd /root/networkprep
7. Run the script:

sh run-networkprep.sh
8. Close the remote SSH connection to the appliance.

 Plan when to upgrade.  Filr services must be offline during the upgrade.

1. Schedule the upgrade for a block of time that is least disruptive from 
a production standpoint.

2. Notify Filr users about the upgrade.

Critical Point Details
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After ensuring that you have met the prerequisites and cautions above, complete the instructions in 
the following sections in order.

 “Understanding the Appliance Upgrade Process” on page 76
 “Downloading and Preparing Software for the Upgrades” on page 77
 “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80
 “Upgrading the VMs” on page 81
 “Deploying the Upgraded (Replacement) VMs” on page 90
 “Performing Post-Upgrade Tasks” on page 91

Understanding the Appliance Upgrade Process
The process of upgrading Micro Focus appliances is illustrated in Figure 10-1 on page 77.

NOTE: Upgrade processes are unchanged from Filr 2.0. If you performed upgrades to Filr 2.0, you 
might find the graphical overview in Figure 10-1 has all the information that you need to proceed.

On the other hand, if you are unsure about any part of the upgrade process, the sections that follow 
the graphic should provide the guidance you need.
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Figure 10-1   Overview of the Appliance Upgrade Process

Downloading and Preparing Software for the Upgrades
Download and prepare the software for your virtualization platform as described in the following 
sections:

VMWare
1 Download the Filr software shown below to your management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

Appliance Type Filename

Filr Filr.x86_64-version.ovf.zip
Search Filrsearch.x86_64-version.ovf.zip
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.ovf.zip

Existing /vashare
NFS or CIFS

(Filr only)

/vastorage
(Disk 2)

New Appliance 1
Location

New /
(Disk 1)

New Appliance 1

New /var
(Disk 3)

Important: The order in which you start the appliances during an upgrade is critical. 
If you have a MySQL appliance, it must be started first, then the two search 
appliances, and finally the Filr appliances.  

Upgrading an Appliance

4. The appliance system prompts you to confirm that you are upgrading.
After you supply a couple of passwords, the system runs through the
configuration screens automatically and the new appliance is an “upgraded”
version of the old appliance.

E

-  Disks: (new /var disk, existing /vashare disk)
-  The correct RAM,
-  A second network adapter if needed,

and so on. 

4. Start and configure the newly deployed VM with: D

1. Deploy the appropriate file to the new 
appliance location for each appliance 
you are upgrading.
This creates a new VM with a 
system disk (/) (Disk 1)

B

Existing Appliance 1

/vastorage
(Disk 2)

2. Download a new version of the Filr,
Filrsearch, (and if needed MySQL) 
appliances for your virtualization 
platform.

A .gz.zip Or

3. Copy Disk 2 of the existing
appliance being upgraded.

Note: For Citrix Xen, you “export”
rather than copying.

C

download.novell.com
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2 Extract each .ovf.zip file on your management workstation until an ApplianceType-version 
folder appears.

3 Launch the vSphere Client and navigate to the datastore where you plan to host the upgraded 
VMs. 

4 Create a folder for each appliance that you plan to upgrade. 
Name each folder with a name that is easily associated with (but not the same as) the VM name 
of the associated appliance being upgraded.
Consider including information in the names that easily identifies the appliance type and other 
information, such as the IP address.
For example, 
 v3-filr-1-30-192.168.1.61
 v3-filr-2-30-192.168.1.62
 v3-filrsearch-1-30-192.168.1.71
 v3-filrsearch-2-30-192.168.1.72

5 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80.

Hyper-V
1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote 

Desktop.
2 Download the Filr software shown below to the location where you plan to host your upgraded 

VMs.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

3 Extract each .vhd.zip file in the directory where you downloaded it until an ApplianceType-
version.vhd archive file appears.

4 Create a new directory for each virtual machine you are upgrading. 
As a best practice, name these directories with names that are easily associated with, but not the 
same as the VM name of each appliance being upgraded. 
Consider including information in the names that easily identifies the appliance type and other 
information, such as the IP address.
For example, 
 v3-filr-1-30-192.168.1.61
 v3-filr-2-30-192.168.1.62
 v3-filrsearch-1-30-192.168.1.71
 v3-filrsearch-2-30-192.168.1.72

Appliance Type Filename

Filr Filr.x86_64-version.vhd.zip
Search Filrsearch.x86_64-version.vhd.zip
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.vhd.zip
78 Upgrading from Filr 2.0 to Filr 3.0

https://www.microfocus.com/products/filr/trial-download


5 Move the filr-version.vhd archive file to the first Filr appliance-type folder and then copy the 
file to the remaining Filr appliance type folders.

6 Move the filrsearch-version.vhd archive file to the first Filrsearch appliance-type folder and 
then copy the file to the second Filrsearch folder.

7 (Optional) If you are deploying a MySQL appliance rather than using an in-house SQL server, 
move the mysql-version.vhd archive file to the MySQL appliance folder.

8 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80.

 Xen
1 Log in to the Xen VM host server either locally or from a remote workstation.

If you are connecting from a remote Linux workstation, use the following command:
ssh -X root@host_ip_address

The -X in the command in required for the GUI installation program upon which the steps in this 
section are based.

2 Download the Filr software shown below to the Xen VM host server in the location where you 
plan to host your upgraded VMs.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Untar each *.gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf ApplianceType.x86_64-version.xen.tar.gz
An ApplianceType-version directory is created for each appliance type.

4 Copy and rename the ApplianceType-version directories until you have one directory for each 
appliance that you are upgrading. 
Also, consider including information in the directory names that easily identifies the appliance 
type and other information, such as the IP address.
For example, 
 filr-1-30-192.168.1.61
 filr-2-30-192.168.1.62
 filrsearch-1-30-192.168.1.71
 filrsearch-2-30-192.168.1.72

IMPORTANT: Only change the directory names. 
Do not change the names of the .raw or .xenconfig files within the directories that you have 
copied and renamed.

For example: 
1. Rename the Filr-version directory to filr-1-30-192.168.1.61.

Appliance Type Filename

Filr Filr.x86_64-version.xen.tar.gz
Search Filrsearch.x86_64-version.xen.tar.gz
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.xen.tar.gz
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2. Copy the filr-1-30-192.168.1.61 directory and rename it to filr-1-30-192.168.1.62, 
and so on until you have a directory for each appliance you are upgrading.

3. In a similar manner, copy and rename the Filrsearch-version directory until you have 
two Filrsearch appliances.

4. If you need a MySQL appliance, follow the same methodology.
5 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80.

Citrix Xen
1 On a workstation with Citrix XenCenter installed, download the Filr software shown below.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

2 Using a program such as 7-Zip, extract each .xva.tar.gz file on your management workstation 
until an ApplianceType-version folder appears.

3 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80.

Copying Each Appliance’s /vastorage Disk (Disk 2)

IMPORTANT

 VMware requires shutting down an appliance before copying a disk. 

This doesn’t mean that the entire service must be down while disk copying takes place. 

If you have a Filr-clustered deployment, you can minimize service interruption by shutting down 
one Filr or Filrsearch appliance, copying the disk, restarting the appliance and continuing with 
the next appliance. 

 On Citrix Xen you “export” rather than copying Disk 2.

Copying each appliance’s disk is at the heart of the upgrade process because it uses the 
corresponding “old” appliance’s configuration settings on Disk 2 to create an upgraded version of the 
appliance with minimal input on your part. 

Disk copying can take a while, depending on disk size and the VM host environment.

Appliance Type Filename

Filr Filr.x86_64-version.xva.tar.gz
Search Filrsearch.x86_64-version.xva.tar.gz
MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.xva.tar.gz
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Therefore, we recommend keeping service downtime to a minimum by making the copies while the 
Filr system is still running. 

1 Using the tools provided by your hypervisor, copy the /vastorage (second disk) to its associated 
folder or directory that you created for your upgraded appliances in “Downloading and Preparing 
Software for the Upgrades” on page 77.

Upgrading the VMs
 “Shutting Down the Appliances” on page 81
 “Upgrading VMware VMs” on page 81
 “Upgrading Hyper-V VMs” on page 84
 “Upgrading and Deploying Xen VMs” on page 85
 “Upgrading Citrix Xen VMs” on page 89

Shutting Down the Appliances
1 Shut down all of your existing appliances in the shut down order that you identified earlier: 
2 Continue with the instructions for your VM platform:

 VMware
 Hypter-V
 Xen
 Citrix Xen

Upgrading VMware VMs
Complete the steps in Table 10-1 for each appliance that you are upgrading

Table 10-1   Upgrading a VMware VM

Page, Dialog, or Option Do This

1 - Launching the vSphere Client. 

1. On your management workstation, start the vSphere Client.

vSphere Client 2 - Deploying the OVF Template and naming the VM. 

1. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. For the appliance type you are deploying, navigate to the contents of the folder 
that you downloaded and extracted in “Downloading and Preparing Software 
for the Upgrades” on page 77.

2. Select and open the.ovf file.
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Deploy OVF Template 1. Name the appliance with the same name of the folder that you created for this 
upgraded appliance in Step 4 on page 78.

2. Click Next.
3. Choose the datastore and folder were you copied the appliance’s Disk 2.

4. Click Next to accept the default for the disk format.

5. Do not select Power on after deployment.
6. Click Finish.

The boot disk is created and the appliance is deployed as specified to this 
point.

3 - Editing the VM settings. 

vSphere Client 1. In the vSphere Client, right-click the VM you just deployed and select Edit 
Settings.

The Virtual Machine Properties dialog displays.

Virtual Machine 
Properties

1. Set the Memory and CPU settings to match the appliance you are replacing, 
or increase them as planned.

 4 - Configuring disk 2 (/vastorage) 

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Hard Disk, click Next and select Use an existing Virtual disk.

2. Click Next > Browse, then navigate to and select the copy of disk 2 that you 
made for this appliance.

3. Click Next > Next > Finish.

 5 - Adding and Configuring disk 3 (/var) 

Virtual Machine 
Properties

1. Click Add.

Page, Dialog, or Option Do This
82 Upgrading from Filr 2.0 to Filr 3.0



Add Hardware 1. Select Hard Disk.

2. Click Next > Next.
3. Adjust the Disk Size to the same size as disk 3 (/var) on the appliance you are 

replacing.

4. Under Disk Provisioning, select either: 

 Thick Provision Eager Zeroed
or 

 Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.

5. Under Location, select Specify a datastore or Datastore cluster
6. Click Browse.

7. Select the datastore and folder for this appliance.

8. Click OK.

9. Click Next.
10. Under the Virtual Device Node section, select SCSI (2:0).
11. Click Next.
12. Click Finish.

13. If you need to add network adapters, continue with 6 - (Optional) Adding a 
Network Adapter. 

Otherwise, click OK, return to “2 - Deploying the OVF Template and naming 
the VM.” on page 81, and deploy the next appliance that you have planned for

When all of your planned appliances have been deployed, continue with 
“Deploying the Upgraded (Replacement) VMs” on page 90.

6 - (Optional) Adding a Network Adapter 

You can add a network adapter if your Filr deployment accesses a separate network 
for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Ethernet Adapter.
2. Click Next.
3. Under Network Connection, select the secondary network associated with 

the Filr installation.

4. Click Next > Finish > OK.

vSphere Client 1. Repeat the steps in this table from 2 - Deploying OVF Template until all of your 
planned appliances have been deployed, then continue with “Deploying the 
Upgraded (Replacement) VMs” on page 90.

Page, Dialog, or Option Do This
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Upgrading Hyper-V VMs
Complete the steps in Table 10-2 for each appliance that you are upgrading.

Table 10-2   Upgrading a Hyper-V VM

Page, Dialog, or Option Do This

1 - Open Hyper-V Manager. 

Hyper-V Host Server 1. Open the Hyper-V Manager.

2 - Create a new VM. 

Hyper-V Manager 1. In the left pane, right-click the server where you have planned to 
create the new virtual machine, then click New > Virtual 
Machine.

The New Virtual Machine Wizard displays.

2. Click Next.

Specify Name and Location 1. Name the appliance with the name of the directory that you 
created for it in Step 4 on page 78.

2. Click Next.

Specify Generation 1. Make sure that Generation 1 is selected. 

2. Click Next.

3 - Specify memory 

Assign Memory 1. In the Startup RAM field, specify the same amount of memory 
(in MB) of the appliance that you are replacing, or increase the 
memory as planned. 

2. Click Next.

4 - Assign network adapter 

Configure Networking 1. On the Configure Networking page, select the networking card 
for this VM.

2. Click Next.

6 - Identify the system disk  

Connect Virtual Hard Disk 1. Select Use an existing virtual hard disk. 

2. Browse to and select the .vhd file in the folder you created for 
this appliance.

3. Click Open.

4. Click Next.

Summary 1. Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.
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Upgrading and Deploying Xen VMs

IMPORTANT: Unlike the other virtualization platforms, which you power on and deploy separately 
from the upgrade process, upgraded Xen VMs power on automatically when the upgrade process 
completes. You must then deploy the appliance before continuing with the next one.

Therefore, it is critical that you make sure to follow the deployment order that you identified earlier.

Complete the steps in Table 10-3 for each appliance that you are upgrading and deploying.

Table 10-3   Upgrading and Deploying a Xen VM

Processor 1. Click Processor.
2. In the Number of virtual processors field, specify the number 

of processors for this VM. 

3. Click Next.

8 - Use existing copy of hard disk 2 (/vastorage). 

Settings for VM on Host Server 1. Add the copy you made of disk 2 to this VM. 

2. When you have added the disk, review the VM summary 
information and click Finish.

9 - Add hard disk 3 (/var). 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

3. Create a new blank virtual disk the same size as disk 3 on the 
appliance you are upgrading.

Summary 1. Review the summary information.

2. Click Finish > OK

10 - (Optional) Add a Network Adapter 

1. If the appliance you are upgrading has a secondary network 
adapter, add that now.

Hyper-V Manager 11 - Repeat until all VMs have upgraded copies 

1. Repeat the steps in this table until all of your planned 
appliances have been deployed, then continue with “Deploying 
the Upgraded (Replacement) VMs” on page 90.

Page, Dialog, or Option Do This

1 - Launch the installer. 

Terminal prompt on Xen VM Host 
Server

1. Run the following command to launch the GUI configuration 
menu:

vm-install

The Create a Virtual Machine wizard is displayed.

Page, Dialog, or Option Do This
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Create a Virtual Machine 1. Click Forward.

Install an Operating System? 1. Select I have a disk or disk image with an installed 
operating system.

2. Click Forward.

Type of Operating System 1. Select SUSE Linux Enterprise Server 11. 

2. Click Forward.

2 - Name the VM. 

Summary 1. Click Name of Virtual Machine.

Name of Virtual Machine 1. In the Name field, type the name of the appliance.

Use the name of the corresponding directory that you prepared 
for the appliance in Step 4 on page 79.

2. (Optional) In the Description field, type additional information 
about the appliance.

3. Click Apply.

3 - Specify the RAM and Virtual Processors. 

Summary 1. Click Hardware.

Hardware 1. Change the Initial Memory and Maximum Memory set the 
amount of memory (in MB) to match that of the VM you are 
upgrading.

2. Change the Virtual Processors setting to match the number of 
the VM you are upgrading.

3. Click Apply.

4 - Configure the boot disk 

Summary 1. Click Disks.

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Navigate to the contents of the folder for the appliance you are 
creating.

2. Select the .raw file.

3. Click Open.

Virtual Disk 1. Click OK.

5 - Configure disk 2 (/vastorage) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file for Disk 2.

2. Click Open.
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Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a name of the copy of disk 2 for this appliance.

5. When you finish linking to the disk, click OK.

6 - Configure disk 3 (/var) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a disk name that reflects the appliance name and that this 
is disk 3. For example, Filr-192.168.1.61-disk-3.

5. Do not change the Storage Format.
6. Change the Size field value to match the size of disk 3 in the 

appliance you are upgrading.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “7 - 
(Optional) Add a Network Adapter.”

Otherwise, click OK and continue with “8 - Deploy the 
Appliance.”

7 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a 
separate network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with 
Filr.

Summary 1. Click Network Adapters.

Network Adapters 1. Click New.

Virtual Network Adapter 1. Specify the settings for the adapter.

2. Click Apply.
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Network Adapters 1. Click Apply.

Summary 1. Click OK.

The virtual machine is created, the appliance starts, and the 
configuration process begins. 

Console 8 - Deploy the Appliance 

1. Access the appliance’s console.

2. When prompted, enter the root and vaadmin passwords for the 
appliance being replaced. 

The upgrade process proceeds automatically.

3. When the appliance displays the final screen in the console 
window, open your management browser and log in to the 
appliance on port 9443 as the vaadmin user.

Port 9443 Admin Console 1. Depending on the appliance type you are upgrading, check the 
following:

 MySQL (optional) : 
1. Click the phpMyAdmin icon.

2. Verify that the database is populated as expected. 

 Filrsearch:  
1. Click the Filrsearch configuration icon.

2. Ensure that all of the settings are in place as 
expected.

3. If the configuration wizard displays, there was a 
problem with the configuration. 

4. Resolve the configuration issues, then click Finish to 
reconfigure the system. 

 Filr: 
1. Click the Filr configuration icon.

2. Ensure that all of the settings are in place as 
expected.

3. If the configuration wizard displays, there was a 
problem with the configuration.

4. Resolve the configuration issues, then click Finish to 
reconfigure the system.

Common configuration issues include:

 If your system is not using DNS, the most likely 
problem is unresolvable DNS names and 
missing /etc/hosts entries.

 If the appliance doesn’t have access to the 
database, ensure that all of the settings are as 
expected.
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Upgrading Citrix Xen VMs

Table 10-4   Upgrading a Citrix Xen VM

11 - Upgrade the Next Appliance 

1. Return to the top of the table and repeat the process for the next 
appliance in your list.

When all of your appliances are running, continue with 
“Performing Post-Upgrade Tasks.”

Page, Dialog, or Option Do This

1 - Launch XenCenter. 

Management 
Workstation

1. Start XenCenter.

XenCenter 1. Connect to the Citrix XenServer where you are deploy the upgraded 
appliances.

2. Right-click the server and select Import.

2 - Import the system disk 

Locate the File you want 
to import

1. Browse to and select the .xva file on your management workstation for the 
appliance that you are upgrading.

2. Click Open.

3. Click Next.

Select the location where 
the imported VM will be 
placed

1. Select the XenServer.

2. Click Next.

Select target storage 1. Select the storage repository for the VM.

2. Click Import.

3 - Select the network adapter 

Select network to 
connect VM

1. Select the virtual network adapter.

2. Click Next.

Review the import 
settings

1. Deselect Start VM(s) after import.
2. Click Finish.

IMPORTANT: Depending on network latency and other factors, it can take a 
while to import the system disk.

4 - Specify Memory 

1. If you need to adjust the memory to the amount of memory, select the newly 
created VM in the left pane.

2. Click the Memory tab.

3. Click Edit, change the setting, and click OK. 

5 - Specify Processors 
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Deploying the Upgraded (Replacement) VMs

IMPORTANT

 Make sure that you deploy (Start and configure) your appliances one at a time.

Attempting to start and configure multiple upgraded appliances at the same time causes timing, 
synchronization, and other problems.

 Also make sure that you deploy the appliances in the deployment order that you identified 
earlier:

1. MySQL (if applicable)
2. Filrsearch
3. Filr

1 Power on the first (or next) appliance in your deployment order list. 
2 Access the appliance’s console.

1. If you need to adjust the CPUs, right-click the newly created VM in the left 
pane. 

2. Select Properties.

3. Click CPU, change the setting, and click OK.

6 - Link to Disk 2 (/vastorage) 

1. With the newly created VM selected in the left pane, add the copy of disk 2 for 
this appliance.

8 - Add Disk 3 (/var) 

Virtual Disks 1. Click Add....

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 3. For 
example, Filr-1-disk-3.

2. Change the Size field value to match that of the appliance you are replacing.

3. Click Add.

9 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a separate network 
for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

1. With the newly created VM selected in the left pane, click the Networking tab.

2. Select the secondary network associated with the Filr installation.. 

XenCenter 1. Repeat the steps in this table until all of your planned appliances have been 
upgraded, then continue with “Deploying the Upgraded (Replacement) VMs” 
on page 90.
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3 When prompted, enter the root and vaadmin passwords for the appliance being replaced. 
The upgrade process proceeds automatically.

4 When the appliance displays the final screen in the console window, open your management 
browser and log in to the appliance on port 9443 as the vaadmin user.

5 Depending on the appliance type you are upgrading, check the following:

6 When the appliance is running, deploy the next appliance.
7 When all of your appliances are running, continue with “Performing Post-Upgrade Tasks.”

Performing Post-Upgrade Tasks
After upgrading to a new version of Filr, you should perform the following tasks to ensure a fully 
functional Filr system:

 “(Optional) Enable Net Folder Sharing” on page 92
 “Re-Enabling SSH on the Filr Search and Database Appliances” on page 92
 “Reset Non-Standard MySQL Ports” on page 92
 “Install Your New Filr License” on page 92

MySQL (optional) Filrsearch Filr

1. Click the phpMyAdmin icon.

2. Verify that the database is 
populated as expected. 

1. Click the Filrsearch 
configuration icon.

2. Ensure that all of the 
settings are in place as 
expected.

3. If the configuration wizard 
displays, there was a 
problem with the 
configuration. 

Resolve the configuration 
issues, then click Finish to 
reconfigure the system.

1. Click the Filr configuration 
icon.

2. Ensure that all of the 
settings are in place as 
expected.

3. If the configuration wizard 
displays, there was a 
problem with the 
configuration. 

Resolve the configuration 
issues, then click Finish to 
reconfigure the system.

Common configuration issues 
include:

 If your system is not using 
DNS, the most likely 
problem is unresolvable 
DNS names and missing /
etc/hosts entries.

 If the appliance doesn’t have 
access to the database, 
ensure that all of the settings 
are as expected.
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(Optional) Enable Net Folder Sharing
Folder sharing is a new feature in Filr 3.0 with an Advanced-Edition license installed. 

If you have Net Folders where you want users to be able to share folders as well as files, you must 
grant folder sharing rights using the Recipient can share folders in this Net Folder with: option as 
documented in “Grant Rights dialog” in the Filr 3.4.1: Administrative UI Reference.

Re-Enabling SSH on the Filr Search and Database Appliances
If you enabled SSH on the search or database appliances before upgrading your Filr system, it is 
disabled after upgrading, and you need to re-enable it. For more information about how to enable 
SSH, see “Managing System Services” in the Filr 3.4.1: Administrative UI Reference.

Reset Non-Standard MySQL Ports
If you are using a MySQL appliance and have set non-standard MySQL port settings, you must reset 
the port for each Filr appliance using the Port 9443 administration utility.

Install Your New Filr License
Upgraded Filr appliances have a 60-day evaluation license installed. 

To prevent a service interruption, you must install your new license by following the instructions in 
“Installing/Updating the Filr License” in the Filr 3.4.1: Administrative UI Reference.

Upgrading an All-in-One (Small) Deployment
Before upgrading a Filr deployment, you must ensure certain requirements are met. See “Before You 
Upgrade!” on page 92 and then complete the instructions in the following sections in order:

 “Small Filr Upgrade Process Overview” on page 93
 “Downloading and Preparing Software” on page 94
 “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 95
 “Upgrading the VMs” on page 96
 “Deploying the Upgraded Filr VM” on page 104
 “Performing Filr Post-Upgrade Tasks” on page 105

Before You Upgrade!
NOTE: As an additional resource to the information in this section, TID 7017288 has a “Pre-Flight 
Checklist” that can help you ensure a successful upgrade.

Failure to comply with the following critical points could result in a non-functional Filr system.

 Review the Release Notes: Check “Upgrade Notes” and “Upgrade” known issues in the Filr 3 
Release Notes before you start the upgrade process.

 Ensure that the VM host has enough unformatted disk space: 
 System Disk (/): A 20 GB disk is created automatically. 
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 Disk 2 (/vastorage): You make a copy of the appliance’s Disk 2.
 Each Disk 3 (/var): You create this disk. The recommended size is 4 GB plus 3 times the 

appliance’s RAM allocation.
 Check the version: Make sure that the existing appliance is running version 2.0 with the latest 

patches applied (see “Managing Field Test Patches” in the Filr 2.0: Administration Guide)
 Remove VMware Snapshots: Before copying Disk 2, make sure to remove all VMware 

snapshots so that the /vastorage disk has the correct disk file and latest configuration settings.
 If the appliance has two network adapters: Do the following:

1. Download the networkprep.zip file from the Filr software downloads page.
2. Enable SSH on the appliance, as described in “Managing System Services” in the Filr 3.4.1: 

Administrative UI Reference.
3. Using an SSH client (such as WinSCP), log in to the appliance as the root user.
4. Copy the networkprep.zip file that you downloaded to the /root/ directory on the 

appliance.
5. Unzip the networkprep.zip file:

unzip networkprep.zip
The networkprep folder is created.

6. Change to the network prep folder:
cd /root/networkprep

7. Run the script:
sh run-networkprep.sh

8. Close the remote SSH connection to the appliance.

After ensuring that you have met the prerequisites and cautions above, complete the instructions in 
the following sections in order.

 “Small Filr Upgrade Process Overview” on page 93
 “Downloading and Preparing Software” on page 94
 “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 95
 “Upgrading the VMs” on page 96
 “Deploying the Upgraded Filr VM” on page 104
 “Performing Filr Post-Upgrade Tasks” on page 105

Small Filr Upgrade Process Overview
If you have upgraded a small Filr deployment before, the following reminder might be all you need.
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Figure 10-2   Overview of the Small Filr Appliance Upgrade Process

Downloading and Preparing Software
Download and prepare the software for your virtualization platform as described in the following 
sections:

VMWare
1 Download the Filr appliance software to your management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

2 Extract the .ovf.zip file on your management workstation until a Filr-version folder appears.
3 Launch the vSphere Client and navigate to the datastore where you plan to host the upgraded 

VM. 
4 Create a folder for the new appliance with a name that is easily associated with (but not the 

same as) the VM name of the appliance being upgraded.
5 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 95.

Hyper-V
1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote 

Desktop.
2 Download the Filr appliance software to the location where you plan to host your upgraded VMs.

/vastorage
(Disk 2)

New Filr Appliance
Location

New /
(Disk 1)

New Filr Appliance

New /var
(Disk 3)

Upgrading a Small Filr Deployment

4. The appliance system prompts you to confirm that you are upgrading.
After you supply a couple of passwords, the system runs through the configuration screens automatically, 
and the new appliance is an “upgraded” version of the old appliance.

E

-  Add/create a new /var disk.
-  Set the correct RAM.
-  Add a second network adapter if needed. 

4. Start and configure the newly deployed appliance. D

1. Deploy the downloaded file to the new 
Filr appliance location.
This creates a new VM with a 
system disk (/) (Disk 1)

B

Existing Filr Appliance

/vastorage
(Disk 2)

2. Download a new version of the Filr appliance 
for your virtualization platform.

A .gz.zip Or

download.novell.com

3. Copy Disk 2 of the existing Filr appliance 
to the new location.

Note: For Citrix Xen, you “export”
rather than copying.

C
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IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

3 Extract the .vhd.zip file in the directory where you downloaded it until an Filr-version.vhd 
archive file appears.

4 Create a directory for the new appliance with a name that is easily associated with, but not the 
same as the VM name of the appliance being upgraded. 

5 Move the Filr-version.vhd archive file to the folder you just created.
6 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 95.

 Xen
1 Log in to the Xen VM host server either locally or from a remote workstation.

If you are connecting from a remote Linux workstation, use the following command:
ssh -X root@host_ip_address

The -X in the command in required for the GUI installation program upon which the steps in this 
section are based.

2 Download the Filr appliance software to the Xen VM host server in the location where you plan to 
host your upgraded VM.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Untar the *.gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf Filr.x86_64-version.xen.tar.gz
A Filr-version directory is created.

4 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 95.

Citrix Xen
1 On a workstation with Citrix XenCenter installed, download the Filr appliance software.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

2 Using a program such as 7-Zip, extract each .xva.tar.gz file on your management workstation 
until a Filr-version folder appears.

3 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 95.

Copying Each Appliance’s /vastorage Disk (Disk 2)

IMPORTANT

 VMware requires shutting down an appliance before copying a disk. 
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This means that Filr services will be down while disk copying takes place. 
 On Citrix Xen you “export” rather than copying Disk 2.

1 Using the tools provided by your hypervisor, copy the /vastorage (second disk) to its associated 
folder or directory that you created for your upgraded appliances in “Downloading and Preparing 
Software” on page 94.

Upgrading the VMs

Shutting Down the Appliance
1 Shut down the Filr appliance using the Port 9443 Appliance Console. 
2 Continue with the instructions for your VM platform:

 Upgrading a Filr VMware VM
 Upgrading a Filr Hyper-V VM
 Upgrading and Deploying a Filr Xen VM
 Upgrading Citrix Xen VMs

Upgrading a Filr VMware VM
Complete the steps in Table 10-5.

Table 10-5   Upgrading the Filr VMware VM

Page, Dialog, or Option Do This

1 - Launching the vSphere Client. 

1. On your management workstation, start the vSphere Client.

vSphere Client 2 - Deploying the OVF Template and naming the VM. 

1. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. Navigate to the contents of the folder that you downloaded and extracted in 
Step 4 on page 94.

2. Select and open the.ovf file.

Deploy OVF Template 1. Name the appliance with the same name of the folder that you created for this 
upgraded appliance in Step 4 on page 94.

2. Click Next.
3. Choose the datastore and folder were you copied the appliance’s Disk 2.

4. Click Next to accept the default for the disk format.

5. Do not select Power on after deployment.
6. Click Finish.

The boot disk is created and the appliance is deployed as specified to this 
point.

3 - Editing the VM settings. 
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vSphere Client 1. In the vSphere Client, right-click the VM and select Edit Settings.

The Virtual Machine Properties dialog displays.

Virtual Machine 
Properties

1. Set the Memory and CPU settings to match the appliance you are replacing, 
or increase them as planned.

 4 - Configuring disk 2 (/vastorage) 

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Hard Disk, click Next and select Use an existing Virtual disk.

2. Click Next > Browse, then navigate to and select the copy of disk 2 that you 
made for this appliance.

3. Click Next > Next > Finish.

 5 - Adding and Configuring disk 3 (/var) 

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Hard Disk.

2. Click Next > Next.
3. Adjust the Disk Size to the same size as disk 3 (/var) on the appliance you are 

replacing.

4. Under Disk Provisioning, select either: 

 Thick Provision Eager Zeroed
or 

 Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.

5. Under Location, select Specify a datastore or Datastore cluster
6. Click Browse.

7. Select the datastore and folder for this appliance.

8. Click OK.

9. Click Next.
10. Under the Virtual Device Node section, select SCSI (2:0).
11. Click Next.
12. Click Finish.

13. If you need to add network adapters, continue with 6 - (Optional) Adding a 
Network Adapter. 

Otherwise, click OK and skip to continue with “Deploying the Upgraded Filr 
VM” on page 104.

Page, Dialog, or Option Do This
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Upgrading a Filr Hyper-V VM
Complete the steps in Table 10-6.

Table 10-6   Upgrading a Filr Hyper-V VM

6 - (Optional) Adding a Network Adapter 

You can add a network adapter if your Filr deployment accesses a separate network 
for one or more of the following reasons:

 Appliance administration.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Ethernet Adapter.
2. Click Next.
3. Under Network Connection, select the secondary network associated with 

the Filr installation.

4. Click Next > Finish > OK.

vSphere Client 1. Continue with “Deploying the Upgraded Filr VM” on page 104.

Page, Dialog, or Option Do This

1 - Open Hyper-V Manager. 

Hyper-V Host Server 1. Open the Hyper-V Manager.

2 - Create a new VM. 

Hyper-V Manager 1. In the left pane, right-click the server where you have planned to 
create the new virtual machine, then click New > Virtual 
Machine.

The New Virtual Machine Wizard displays.

2. Click Next.

Specify Name and Location 1. Name the appliance with the name of the directory that you 
created for it in Step 4 on page 95.

2. Click Next.

Specify Generation 1. Make sure that Generation 1 is selected. 

2. Click Next.

3 - Specify memory 

Assign Memory 1. In the Startup RAM field, specify the same amount of memory 
(in MB) of the appliance that you are replacing, or increase the 
memory as planned. 

2. Click Next.

Page, Dialog, or Option Do This
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Upgrading and Deploying a Filr Xen VM
Complete the steps in Table 10-7.

4 - Assign network adapter 

Configure Networking 1. On the Configure Networking page, select the networking card 
for this VM.

2. Click Next.

6 - Identify the system disk  

Connect Virtual Hard Disk 1. Select Use an existing virtual hard disk. 

2. Browse to and select the .vhd file in the folder you created for 
this appliance.

3. Click Open.

4. Click Next.

Summary 1. Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

Processor 1. Click Processor.
2. In the Number of virtual processors field, specify the number 

of processors for the VM. 

3. Click Next.

8 - Use existing copy of hard disk 2 (/vastorage). 

Settings for VM on Host Server 1. Add the copy you made of disk 2 to this VM. 

2. When you have added the disk, review the VM summary 
information and click Finish.

9 - Add hard disk 3 (/var). 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

3. Create a new blank virtual disk the same size as disk 3 on the 
appliance you are upgrading.

Summary 1. Review the summary information.

2. Click Finish > OK

10 - (Optional) Add a Network Adapter 

1. If the appliance you are upgrading has a secondary network 
adapter, add that now.

Hyper-V Manager 11 - Deploy the upgraded appliance 

1. Continue with “Deploying the Upgraded Filr VM” on page 104.

Page, Dialog, or Option Do This
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Table 10-7   Upgrading and Deploying a Filr Xen VM

Page, Dialog, or Option Do This

1 - Launch the installer. 

Terminal prompt on Xen VM Host 
Server

1. Run the following command to launch the GUI configuration 
menu:

vm-install

The Create a Virtual Machine wizard is displayed.

Create a Virtual Machine 1. Click Forward.

Install an Operating System? 1. Select I have a disk or disk image with an installed 
operating system.

2. Click Forward.

Type of Operating System 1. Select SUSE Linux Enterprise Server 11. 

2. Click Forward.

2 - Name the VM. 

Summary 1. Click Name of Virtual Machine.

Name of Virtual Machine 1. In the Name field, type the name of the appliance.

Use the name of the corresponding directory that you prepared 
for the appliance in Step 2 on page 95.

2. (Optional) In the Description field, type additional information 
about the appliance.

3. Click Apply.

3 - Specify the RAM and Virtual Processors. 

Summary 1. Click Hardware.

Hardware 1. Change the Initial Memory and Maximum Memory set the 
amount of memory (in MB) to match that of the VM you are 
upgrading.

2. Change the Virtual Processors setting to match the number of 
the VM you are upgrading.

3. Click Apply.

4 - Configure the boot disk 

Summary 1. Click Disks.

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Navigate to the contents of the folder for the appliance you are 
creating.

2. Select the .raw file.

3. Click Open.

Virtual Disk 1. Click OK.

5 - Configure disk 2 (/vastorage) 
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Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file for Disk 2.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a name of the copy of disk 2 for this appliance.

5. When you finish linking to the disk, click OK.

6 - Configure disk 3 (/var) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a disk name that reflects the appliance name and that this 
is disk 3. For example, Filr-192.168.1.61-disk-3.

5. Do not change the Storage Format.
6. Change the Size field value to match the size of disk 3 in the 

appliance you are upgrading.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “7 - 
(Optional) Add a Network Adapter.”

Otherwise, click OK and continue with “8 - Deploy the 
Appliance.”

7 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a 
separate network for one or more of the following reasons:

 Appliance administration.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with 
Filr.

Summary 1. Click Network Adapters.

Page, Dialog, or Option Do This
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Upgrading Citrix Xen VMs
Complete the steps in Table 10-8.

Network Adapters 1. Click New.

Virtual Network Adapter 1. Specify the settings for the adapter.

2. Click Apply.

Network Adapters 1. Click Apply.

Summary 1. Click OK.

The virtual machine is created, the appliance starts, and the 
configuration process begins. 

Console 8 - Deploy the Appliance 

1. Access the appliance’s console.

2. When prompted, enter the root and vaadmin passwords for the 
appliance. 

The upgrade process proceeds automatically.

3. When the appliance displays the final screen in the console 
window, open your management browser and log in to the 
appliance on port 9443 as the vaadmin user.

Port 9443 Admin Console 1. Check the following:

 MySQL (optional) : 

 Click the phpMyAdmin icon.

 Verify that the database is populated as expected. 

 Filr: 

 Click the Filr configuration icon.

 Ensure that all of the settings are in place as 
expected.

 If the configuration wizard displays, there was a 
problem with the configuration.

 Resolve the configuration issues, then click Finish to 
reconfigure the system.

Common configuration issues include:

 If your system is not using DNS, the most likely 
problem is unresolvable DNS names and 
missing /etc/hosts entries.

 If the appliance doesn’t have access to the 
database, ensure that all of the settings are as 
expected.

2. When the appliance is running, continue with “Performing Filr 
Post-Upgrade Tasks.”

Page, Dialog, or Option Do This
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Table 10-8   Upgrading a Citrix Xen VM

Page, Dialog, or Option Do This

1 - Launch XenCenter. 

Management 
Workstation

1. Start XenCenter.

XenCenter 1. Connect to the Citrix XenServer where you planned to deploy Filr.

2. Right-click the server and select Import.

2 - Import the system disk 

Locate the File you want 
to import

1. Browse to and select the .xva file on your management workstation.

2. Click Open.

3. Click Next.

Select the location where 
the imported VM will be 
placed

1. Select the XenServer.

2. Click Next.

Select target storage 1. Select the storage repository for the VM that you used in Step 2 on page 95.

2. Click Import.

3 - Select the network adapter 

Select network to 
connect VM

1. Select the virtual network adapter.

2. Click Next.

Review the import 
settings

1. Deselect Start VM(s) after import.
2. Click Finish.

IMPORTANT: Depending on network latency and other factors, it can take a 
while to import the system disk.

4 - Specify Memory 

1. If you need to adjust the memory to the amount of memory, select the newly 
created VM in the left pane.

2. Click the Memory tab.

3. Click Edit, change the setting, and click OK. 

5 - Specify Processors 

1. If you need to adjust the CPUs, right-click the newly created VM in the left 
pane. 

2. Select Properties.

3. Click CPU, change the setting, and click OK.

6 - Link to Disk 2 (/vastorage) 

1. With the newly created VM selected in the left pane, add the copy of disk 2 for 
this appliance.

8 - Add Disk 3 (/var) 

Virtual Disks 1. Click Add....
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Deploying the Upgraded Filr VM
1 Power on the appliance. 
2 Access the appliance’s console.
3 When prompted, enter the root and vaadmin passwords for the appliance. 

The upgrade process proceeds automatically.
4 When the appliance displays the final screen in the console window, open your management 

browser and log in to the appliance on port 9443 as the vaadmin user.
5 Check the following:

 MySQL : 
 Click the phpMyAdmin icon.
 Verify that the database is populated as expected. 

 Filr: 
 Click the Filr configuration icon.
 Ensure that all of the settings are in place as expected.
 If the configuration wizard displays, there was a problem with the configuration.
 Resolve the configuration issues, then click Finish to reconfigure the system.

Common configuration issues include:
 If your system is not using DNS, the most likely problem is unresolvable DNS 

names and missing /etc/hosts entries.
 If the appliance doesn’t have access to the database, ensure that all of the 

settings are as expected.
6 When the appliance is running, continue with “Performing Post-Upgrade Tasks.”

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 3. For 
example, Filr-1-disk-3.

2. Change the Size field value to match that of the appliance you are replacing.

3. Click Add.

9 - (Optional) Add a Network Adapter 

You can add a network adapter if your Filr deployment accesses a separate network 
for one or more of the following reasons:

 Appliance administration.

 Security of Memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

1. With the newly created VM selected in the left pane, click the Networking tab.

2. Select the secondary network associated with the Filr installation.. 

XenCenter 1. Continue with “Deploying the Upgraded Filr VM” on page 104.

Page, Dialog, or Option Do This
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Performing Filr Post-Upgrade Tasks
After upgrading to a new version of Filr, you should perform the following tasks to ensure a fully 
functional Filr system:

 “(Optional) Enable Net Folder Sharing” on page 105
 “Install Your New Filr License” on page 105

(Optional) Enable Net Folder Sharing
Folder sharing is a new feature in Filr 3.0 with an Advanced-Edition license installed. 

If you have Net Folders where you want users to be able to share folders as well as files, you must 
grant folder sharing rights using the Recipient can share folders in this Net Folder with: option as 
documented in “Grant Rights dialog” in the Filr 3.4.1: Administrative UI Reference.

Install Your New Filr License
Upgraded Filr appliances have a 60-day evaluation license installed. 

To prevent a service interruption, you must install your new license by following the instructions in 
“Installing/Updating the Filr License” in the Filr 3.4.1: Administrative UI Reference.
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11 11Updating to Filr 3.4

Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 appliances or later. 
Previous upgrade methods do not apply to Filr 3.4. Note the following:

 No Separate Hypervisor-specific Downloads: The virtual machine configurations are not 
impacted.

For information about using the Online Update feature, see “Using the Online Update dialog” in the 
Filr 3.4.1: Administrative UI Reference.

IMPORTANT

 We recommend that you schedule online updates only for updating non-interactive patches on 
Filr Appliance 3.1.1 or later.

 If you change the IP address of the proxy server that is configured on the Filr Appliances, then 
you must update the proxy server configuration on the Filr Appliances before registering and 
applying the online updates:

1. On the Filr Appliance, use the Yast Proxy Management tool to reconfigure the proxy server.
2. Launch a new terminal.
3. Run the following command to restart the datamodel services:

rcnovell-datamodel restart
4. Run the following command to restart the jetty services:

rcnovell-jetty restart

Review the following sections:

 “Updating an All-in-One (Small) Deployment” on page 107
 “Updating a Large Filr Deployment” on page 108

Updating an All-in-One (Small) Deployment
1 Ensure that the version of the Filr appliance is 3.0 or later.
2 Log in to the Filr Appliance Configuration Console (https://appliance_ip_or_dns:9443) as 

vaadmin.
3 Click Online Update.
4 In the Patches drop-down option, select Needed Patches and ensure that the Filr 3.4 patch 

update is listed.
5 Click Update Now.
6 In the Update Now dialog, do the following:

6a In the Apply drop-down option, select All Needed Patches.
6b Select both the Automatically agree with all license agreements and the Automatically 

install all interactive patches options.
Updating to Filr 3.4 107

https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#t40vl85hf0xf
https://www.novell.com/documentation/filr-3/pdfdoc/filr-admin/filr-admin.pdf#bookinfo


IMPORTANT: The Filr 3.4 update is an interactive update and requires you to select both 
the options before you run the update. If you do not select these options, the update 
process fails. However, the progress bar incorrectly displays that the update is in progress.

7 Click OK.
A progress bar displays the status of the update. After the update completes, select the Installed 
Patches option in the drop-down and verify that the Filr 3.4 patch is listed there.

Updating a Large Filr Deployment
IMPORTANT: Before you apply this update on any appliance, you must stop the Filr service on all the 
Filr appliances in order to avoid interruptions to the service when it is restarted. 

Perform the following steps on every Filr appliance in the cluster:

1 Ensure that the version of the Filr appliance is 3.0 or later.
2 Log in to the Filr Appliance Configuration Console (https://appliance_ip_or_dns:9443) as 

vaadmin.
3 Click Online Update.
4 In the Patches drop-down option, select Needed Patches and ensure that the Filr 3.4 patch 

update is listed.
5 Click Update Now.
6 In the Update Now dialog, do the following:

6a In the Apply drop-down option, select All Needed Patches.
6b Select both the Automatically agree with all license agreements and the Automatically 

install all interactive patches options.

IMPORTANT: The Filr 3.4 update is an interactive update and requires you to select both 
the options before you run the update. If you do not select these options, the upgrade 
process fails. However, the progress bar incorrectly displays that the upgrade is in progress.

7 Click OK.
A progress bar displays the status of the update. After the update completes, select the Installed 
Patches option in the drop-down and verify that the Filr 3.4 patch is listed there.
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12 12Setting Up Sharing 

IMPORTANT: Filr 3.4 is available as an online update to Filr 3.0, MySQL 3.0, and Filr Search 3.0 
appliances or later.

 To Install a New Filr 3.4 Appliance: You must install and configure Filr 3.0, and then apply the 
3.4 updates. To apply the Filr 3.4 updates, see Chapter 11, “Updating to Filr 3.4,” on page 107.

Before users can share, they must have sharing enabled for them at the Filr system level, either 
individually or as a member of a group. 

After that, sharing of My Files is enabled by default, but sharing in Net Folders requires additional 
steps.

Use the following sections as a guide through the process of setting up sharing.

 “Enabling Users to Share” on page 109
 “Do Not Enable Sharing for All Internal Users and All External Users” on page 115
 “System-Level Sharing Must Be Configured First” on page 115
 “My Files Sharing Is Automatic” on page 116
 “Net Folder Sharing Must Be Explicitly Allowed At Two Levels” on page 116

Enabling Users to Share
 “Best Practices for Setting Up Sharing” on page 109
 “General Order for Setting Up Sharing” on page 110
 “Enabling Sharing for Specific Net Folders” on page 114
 “Restricting Sharing Files by Group of Users” on page 114

Best Practices for Setting Up Sharing
 Enable Sharing for the Filr System: You must enable the sharing feature before any sharing 

can take place on the Filr system. 

As a best practice, enable sharing in an unrestricted way for those users and groups that will be 
allowed to share. 

 If Needed, Restrict My Files Sharing: Enabling sharing automatically lets all users share files 
in their My Files area, including in their Home folder and in personal storage.
You can restrict My Files sharing on a per-user basis if desired.

 Carefully Restrict Net Folder Sharing: Net Folder sharing must be explicitly allowed for each 
Net Folder. 

IMPORTANT: Make sure that only those who need to share a Net Folder’s contents are granted 
sharing rights on that Net Folder. 
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For example, Group A is granted rights to share files in Net Folder A. User A (a member of 
Group A) then shares a file with User B (a member of Group B). Because the file contains 
sensitive information, User A doesn’t grant User B permission to reshare the file. 
As long as User B doesn’t have rights to share files in Net Folder A, there is no problem. 
However, if Group B also has permission to share Net Folder A’s files, then User B can reshare 
the file even though User A assumed otherwise.

General Order for Setting Up Sharing
When you set up sharing for your Filr site, complete the necessary steps in the following order:

1 Set up sharing for the entire Filr site (as described in “Enabling Sharing in Filr” on page 110).
2 Configure sharing for individual users (as described in “Restricting Personal Storage Sharing” on 

page 113).
After you have enabled sharing for the entire Filr system, you can fine-tune share rights 
throughout the site on the user level. 
For example, if you want only a few groups of users to be allowed to share with external users, 
you first need to enable sharing to external users at the site level. After you have enabled it at 
the site level, you can then remove this ability from the users who you do not want to have this 
ability.

3 Set up sharing for specific Net Folders (as described in “Enabling Sharing for Specific Net 
Folders” on page 114).
Users who are given share rights on a specific Net Folder are able to share files within that Net 
Folder that they have rights to at least view on the file system.

Enabling Sharing in Filr
After you set up sharing for the entire Filr site, all users by default are granted rights to share files in 
the My Files area (this includes files in the Home folder and files in personal storage), with the site-
wide access rights that you specify. If you want only certain users to be allowed to share files from 
their My Files area, you must enable sharing for the entire site as described in this section. Then you 
must restrict sharing privileges at the user level, as described in “Restricting Personal Storage 
Sharing” on page 113.

1 Log in to the Filr site as the Filr administrator.
1a Launch a web browser. 
1b Specify one of the following URLs, depending on whether you are using a secure SSL 

connection:

http://Filr_hostname:8080
https://Filr_hostname:8443
Replace Filr_hostname with the hostname or fully qualified domain name of the Filr server 
that you have set up in DNS.
Depending on how you have configured your Filr system, you might not be required to enter 
the port number in the URL. If you are using NetIQ Access Manager, the Filr login screen is 
not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console 
icon . 

3 Under System, click Share Settings.
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The Share Settings page is displayed.

4 Select Allow all users to share with groups that have been imported from LDAP to enable 
users to share with LDAP groups.
If you select this option, groups that were imported from the LDAP directory are displayed in the 
Share with field when users are sharing an item (as described in “Sharing Files and Folders” in 
the Filr 3.4: User Access Guide). All users in the LDAP group then have access to the item that 
was shared.

Enabling Users and Groups for Net Folder Sharing
1 To enable sharing for all internal users on the Filr site, go to the User or Group field, begin typing 

All Internal Users, then select it when it appears in the drop-down list.
or
To enable sharing on a per-user or per-group basis, go to the Select user/group field, begin 
typing the name of the user or group for whom you want to grant share rights, then select the 
name when it appears in the drop-down list.
The Edit Share Rights dialog box is displayed. Select from the following options:
Re-share items: When users share a file or folder, they can give the users they are sharing with 
the ability to re-share the file or folder. The user receiving the share can share the file only if that 
user has been given administrative rights to share the file or folder.

IMPORTANT: When selecting this option, be aware that if one user's access rights to an item 
are removed, it does not remove the access rights of the user with whom the item was re-shared.
For example, suppose User A shares an item with User B and grants re-share rights. User B 
then shares the item with User C. If User A revokes User B's access rights to the item, User C 
continues to have access to the shared item. 

Share with Internal users: Allows users to share items with internal users.
Share with “All Internal Users” group: Allows users to perform a mass share to all internal 
users by sharing with the All Internal Users group.
Share with External users: Allows users to share items with users external to the organization. 
Users external to the organization receive an email notification with a link to the shared item, and 
they can then log in to the Filr site. For more information, see “Sharing with People Outside Your 
Organization” in the Filr 3.4: User Access Guide.
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Share with Public: Allows users to make items publicly available. This means that anyone with 
the correct URL to the shared item can access the shared item without logging in to the Filr site.
In addition to selecting this option, you also need to enable Guest access to the Filr site if you 
want to allow users to share items with the public. For information about how to enable Guest 
access to the Filr site, see 
Share using File Link: Allows users to share a link to a file in Filr. Any user with the link can 
then access the file. However, the file is not displayed in the Public area, so users must have 
direct access to the link in order to access the file.

NOTE: If you select this option, users can share a link of the Filr file even with email addresses 
that are listed in the Blacklist field.

For more information about File Links, see “Distributing a Link to a File” in the Filr 3.4: User 
Access Guide.

2 (Optional) Click the Whitelist / Blacklist tab to configure which email addresses and domains 
users can share with when sharing externally.

The following options are available when configuring a whitelist or blacklist for sharing:
No restrictions: Select this option to disregard any email addresses or domains that might 
already exist in the Email addresses and Domains fields. Selecting this option means that users 
can share with any email address.
Whitelist: Select this option to allow sharing only with email addresses and domains that have 
been specified in the Email addresses and Domains fields.
Email addresses: Click Add, specify the email address that you want to add to the whitelist or 
blacklist, then click OK.
Blacklist:  Select this option to disallow sharing with any email addresses and domains that 
have been specified in the Email addresses and Domains fields.
Repeat this process to add multiple email address.
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NOTE: If a user has Share using File Link rights, the user can share links of Filr files even with 
the blacklisted email addresses.

Domains: Click Add, specify the domain that you want to add to the whitelist or blacklist (for 
example, yahoo.com), then click OK.
Repeat this process to add multiple domains.
Delete shares that don’t meet the criteria: Select this option to delete all existing shares in the 
Filr system that do not match the criteria you set. 
For example, if you selected Blacklist and then specified yahoo.com in the Domains field, 
selecting this option would delete all Filr shares made to Yahoo email addresses.

3 Click OK.

Restricting Personal Storage Sharing
After you have enabled sharing of files for the entire Filr system (as described in “Enabling Sharing in 
Filr” on page 110), you can restrict shared-access right granting on an individual-user basis.

You cannot grant individual users more rights than are currently defined for the site-wide setting.

To restrict share rights for specific users:

1 Log in to the Filr site as the Filr administrator.
1a Launch a web browser. 
1b Specify one of the following URLs, depending on whether you are using a secure SSL 

connection:

http://Filr_hostname:8080
https://Filr_hostname:8443
Replace Filr_hostname with the hostname or fully qualified domain name of the Filr server 
that you have set up in DNS.
Depending on how you have configured your Filr system, you might not be required to enter 
the port number in the URL. If you are using NetIQ Access Manager, the Filr login screen is 
not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console 
icon . 

3 Under Management, click Users.
4 Select the users whose sharing rights you want to manage, then click More > Workspace Share 

Rights.
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5 Select the radio button in the Clear column next to the sharing right that you want to remove from 
the user or group, then click OK.
or
If you have already removed a share right and you want to add it again, select the radio button in 
the Allow column next to the sharing right that you want to add to the user or group, then click 
OK.

Enabling Sharing for Specific Net Folders
1 Ensure that you have configured sharing as described in “Enabling Sharing in Filr” on page 110.
2 Configure sharing for the Net Folder.

Restricting Sharing Files by Group of Users 
On applying the 3.4.3 Update, you can restrict a group of users from sharing files to others.

1 Apply the 3.4.3 Filr update.
2 Stop the Filr service.

rcfilr stop 
3 Add the following two lines to the /opt/novell/filr/apache-tomcat/webapps/ssf/WEB-INF/

classes/config/ssf-ext.properties file:
Syntax:

 enable.sharing.exception=true
 enable.sharing.exception.list=<GroupName>

GroupName is the name of the group that you do not want to have the ability to share the 
files.
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4 Start the Filr service.
rcfilr start

Do Not Enable Sharing for All Internal Users and All 
External Users

Prior to the release of Filr 2.0, the documentation stated that enabling sharing for All Internal 
Users and All External Users was an acceptable method of enabling sharing on the system. 

Unfortunately, this shortcut results in significant system overhead and often leads to serious 
performance degradation.

We strongly recommend that you enabling sharing only for specific users and/or groups, as outlined 
in the sections that follow.

System-Level Sharing Must Be Configured First
The first step in allowing Filr sharing to take place is to list the users and groups who are allowed to 
share in the Share Settings dialog. When you add the user or group, you also specify the upper limits 
of possible sharing rights for them. You can further restrict the rights, but you can’t expand them 
beyond this limit.

Figure 12-1   Setting Up System-Level Sharing Rights

1. Click Share Settings.

Group A2. Begin typing, then select 
a user or group.

3. Select the highest
level of rights that the 
user or group will need in 
Filr, then click OK.
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My Files Sharing Is Automatic
After sharing is enabled at the system level for users individually or as members of groups, then if 
those users have personal storage enabled, they can share their files and folders within the 
limitations set for the system. 

Administrators can disable sharing of files and folders in My Files on an individual user basis.

Figure 12-2   My Files Share Settings

Net Folder Sharing Must Be Explicitly Allowed At Two 
Levels

Before the users or groups listed in the Share Settings dialog can share files and folders in their 
assigned Net Folders, they must have sharing enabled on those Net Folders. 

When enabling Net Folder access for a user or group, a Filr administrator can only assign up to the 
maximum sharing rights that are set at the system level.

In Figure 12-3, user red can only be assigned sharing rights that are allowed at the system level.

System-level share settings 

Internal
Users

External
Users

User Red

Guest
Users

Re-Sharing

Re-Share

determine My Files settings.

File
Link
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Figure 12-3   An Example of Net Folder Sharing

System-level share settings limit the sharing rights 
that can be granted 

to a Net Folder user.
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Files & Folders
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II IIAppendixes

The following:

 Appendix A, “Access Manager (NAM) and Filr Integration,” on page 121
 Appendix B, “All-in-One (Small) Deployment—Creating,” on page 129
 Appendix C, “MySQL Appliance—Configuring (Alternate Practice),” on page 131
 Appendix D, “Non-Expandable Deployment—Creating,” on page 133
 Appendix E, “OES 2015 NSS AD as a Net Folder Server,” on page 135
 Appendix F, “SCSI Controller Type—Changing on VMware,” on page 137
 Appendix G, “Troubleshooting the Filr Installation and Upgrade,” on page 139
 Appendix H, “Third-Party Materials,” on page 143
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A AAccess Manager (NAM) and Filr 
Integration

You can configure NetIQ Access Manager (NAM) to act as Proxy service for a Filr site. This helps you 
provide the ease of single sign-on and establish a trusted relationship with the Access Gateway. 
Using Micro Focus Filr in conjunction with NetIQ Access Manager adds enterprise-level security to 
your Filr system.

NOTE: Guest users cannot access Filr through NAM.

Review the following sections:

 “Overview” on page 121
 “Configuring Filr Ports” on page 122
 “Downloading and Installing the Filr Authentication Plugin” on page 122
 “Configuring the NAM Identity Server” on page 122
 “Configuring a Reverse-Proxy Single Sign-On Service for Micro Focus Filr” on page 124

Overview
To integrate Filr with NAM, you must configure the NetIQ Access Manager Identity Server, the Access 
Gateway, and configure protected resources for a Micro Focus Filr server.

 “Filr 3.1 and NAM” on page 121

Filr 3.1 and NAM
The integration of Filr 3.1 with NAM allows both LDAP and non-LDAP (local and external) users to log 
in to Filr through NAM. However, guest users cannot access Filr 3.1 through NAM.

To integrate Filr 3.1 with NAM for non-LDAP users, you must create new classes, methods, and 
contracts in NAM. For LDAP users, you can either use the predefined NAM classes, methods, and 
contracts, or create new ones. If you have both LDAP and non-LDAP users, then you can create a 
new class, method, and contract to support the authentication for both LDAP and non-LDAP users.

Filr 3.1 introduces a new authentication plugin to enable both LDAP and non-LDAP (local and 
external) users to log in to Filr through NAM. To download and install the authentication plugin, see 
“Downloading and Installing the Filr Authentication Plugin” on page 122.

Filr 3.1 requires Access Manager 4.2 or later. For information about NetIQ Access Manager, see the 
Access Manager Documentation website.
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Configuring Filr Ports 
Use the following port configuration when NetIQ Access Manager is fronting your Filr system:

 HTTP Port: 80
 Secure HTTP Port: 443

You must configure the port on the Reverse Proxy and Network page of the Port 9443 Appliance 
Console. For more information, see “Reverse Proxy Configuration Settings” and “Network 
Configuration” in the Filr 3.4.1: Administrative UI Reference.

Downloading and Installing the Filr Authentication 
Plugin 

To enable Filr 3.1 users to access the Filr services through NetIQ Access Manager (NAM), Filr 
provides an authentication plugin that you must download and install on the NAM server that you 
want to use as a proxy server.

To download and install the plugin:

1 Open a browser on your administrative workstation and access the Port 9443 Appliance Console 
on the first Filr appliance using the following URL:
https://Filr_IP_Address:9443
Where Filr_IP_Address is the IP address of the Filr appliance.

2 Click the Configuration  and then click Reverse Proxy. 
3 In the NetIQ Access Manager Integration section, click Filr Plugin for NAM to download the 

FilrAuthClass.jar file. 
4 Copy the FilrAuthClass.jar file to the following locations on the NAM server:

 Linux: /opt/novell/nids/lib/webapp/WEB-INF/lib
 Windows:  C:\Program Files (x86)\Novell\Tomcat\webapps\nidp\WEB-INF\classes

5 Run the following commands to restart the Identity Server and the Access Gateway:
 Identity Server:  /etc/init.d/novell-idp restart
 Access Gateway: /etc/init.d/novell-mag restart

Configuring the NAM Identity Server
 “Configuring the Identity User Store” on page 122
 “Creating the Authentication Class” on page 123
 “Creating the Authentication Method” on page 123
 “Creating the Authentication Contract” on page 123

Configuring the Identity User Store
Configure an identity user store to which the Filr users should authenticate. See “Configuring Identity 
User Stores” in the NetIQ Access Manager Administration Guide.
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Creating the Authentication Class 
Authentication classes let you define ways of obtaining end-user credentials. 

Perform the following steps to create a class:

1 Log in to the NAM Administration Console.
2 Click Devices > Identity Server > Servers > Edit > Local > Classes.
3 Click New to launch the Create Authentication Class wizard, then fill in the following fields:

 Display name: Specify a name for the class.
 Java class: Select Other.
 Java class path: Specify com.novell.nam.authentication.FilrAuthClass.

4 Click Next and then click New to add the following properties for the class:
 Property Name: Specify FilrWsURL.
 Property Value: Specify the HTTP or HTTPS URL of the Filr server in the format: 

http(s)://IP_Address_of_Filr_Server:port_number.
5 Continue with Creating the Authentication Method.

Creating the Authentication Method
Authentication methods let you associate authentication classes with user stores.

1 Log in to the NAM Administration Console.
2 click Devices > Identity Server > Servers > Edit > Local > Methods.
3 Click New to launch the Create Authentication Method wizard, then fill in the following fields:

 Display name: Specify a name for the method.
 Class: Specify the name of the class that you created in Creating the Authentication Class.
 Identifies User:  Ensure that this option is selected.
 User stores:  Add user stores to search. You can select from the list of all the user stores 

you have set up. If you have several user stores, the system searches through them based 
on the order specified here. If a user store is not moved to the User stores list, users in that 
user store cannot use this method for authentication.

4 Continue with Creating the Authentication Contract.

Creating the Authentication Contract
Authentication contracts define how authentication occurs. Perform the following steps to create a 
new contract with the authentication method you created in Creating the Authentication Method.

1 Log in to the NAM Administration Console.
2 click Devices > Identity Server > Servers > Edit > Local > Contracts.
3 Click New to launch the Create Authentication Method Wizard, then fill in the following fields:

 Display name: Specify a name for the contract.
 Methods:  Add the authentication methods that you created before from the list of the 

available methods.
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4 To save the configuration changes, click Devices > Identity Servers, then click Update All.
5 Continue with “Configuring a Reverse-Proxy Single Sign-On Service for Micro Focus Filr” on 

page 124.

Configuring a Reverse-Proxy Single Sign-On Service 
for Micro Focus Filr

The Access Gateway can be configured as a reverse proxy server that provides single sign-on to Filr 
and restricts access to the Filr server by securely providing credential information for authenticated 
users. 

To configure a reverse-proxy single sign-on service for Filr, complete the following tasks:

 “Creating a New Reverse Proxy” on page 124
 “Configuring the Proxy Service” on page 124
 “Creating Policies” on page 125
 “Configuring Protected Resources” on page 126
 “Configuring a Rewriter Profile” on page 127

Creating a New Reverse Proxy
You must ensure that the Reverse Proxy that you use for integrating NAM with Filr listens on the 
default HTTP (port 80) and HTTPS (port 443) ports.

Before you can configure the proxy service, you need to create a new reverse proxy. See 
“Configuring a Reverse Proxy” in the NetIQ Access Manager Administration Guide. 

Configuring the Proxy Service
1 In the NAM Administration Console, click Devices > Access Gateways > Edit, then click the 

name of the reverse proxy that you created in “Creating a New Reverse Proxy” on page 124.
2 In the Reverse Proxy List, click New and then fill in the following fields:

Proxy Service Name: Specify a display name for the proxy service.
Published DNS Name: Specify the publicly-available DNS name for accessing your Filr site. 
This DNS name must resolve to the IP address you set up as the listening address. For 
example, filr.doc.provo.microfocus.com.
Web Server IP Address: Specify the IP address of the Filr server.
Host Header: Select Forward Received Host Name.
Web Server Host Name: Because of your selection in the Host Header field, this option is 
dimmed.

3 Click OK.
4 Click the newly added proxy service, then select the Web Servers tab.
5 Change the Connect Port to the default HTTP or HTTPS Filr web service port.
6 Click OK.
7 Continue with “Creating Policies” on page 125.
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Creating Policies
You need to create two policies: LDAP Identity Injection and X-Forwarded-Proto:

 “Creating the LDAP Identity Injection Policy” on page 125
 “Creating the X-Forwarded-Proto HTTP Header Policy” on page 125

Creating the LDAP Identity Injection Policy
1 In the NAM Administration Console, click Policies > Policies. 
2 Select the policy container, then click New.
3 Specify ldap_auth as the name for the policy, select Access Gateway: Identity Injection for the 

type, then click OK.
4 (Optional) Specify a description for the injection policy. This is useful if you plan to create multiple 

policies to be used by multiple resources.
5 In the Actions section, click New, then select Inject into Authentication Header.
6 Fill in the following fields: 

User Name: If users are provisioned with cn or uid attributes, select Credential Profile, then 
select LDAP Credentials:LDAP User Name. In the Refresh Data Every drop-down, select 
Session. 
Password: Select Credential Profile, then select LDAP Credentials:LDAP Password.

7 Leave the default value for the Multi-Value Separator, which is comma.
8 Click OK.
9 To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Authentication Header 
Policy” in the NetIQ Access Manager Administration Guide.

Creating the X-Forwarded-Proto HTTP Header Policy
If your network provides HTTPS (secure) connections between browsers and NAM but HTTP 
(insecure) connections between NAM and Filr, we strongly recommend creating an X-Forwarded-
Proto HTTP Header Policy as a best practice.

1 In the NAM Administration Console, click Policies > Policies. 
2 Select the policy container, then click New.
3 Specify x-forward as the name for the policy, select Access Gateway: Identity Injection for the 

type, then click OK.
4 (Optional) Specify a description for the injection policy. This is useful if you plan to create multiple 

policies to be used by multiple resources.
5 In the Actions section, click New, then select Inject into Custom Header.
6 Fill in the following fields: 

Custom Header Name: Specify X-Forwarded-Proto as the name.
Value: Select String Constant in the drop-down, then specify https.

7 Leave the other settings at the defaults.
8 Click OK.
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9 To save the policy, click OK, then click Apply Changes.
For more information on creating such a policy, see “Configuring an Authentication Header 
Policy” in the NetIQ Access Manager Administration Guide.

Configuring Protected Resources
You must create two protected resources: a protected resource for HTML content and a public 
protected resource for web services.

1 Create a protected resource for HTML content:
1a In the Protected Resource List, click New. Specify a name, then click OK. 
1b (Optional) Specify a description for the protected resource. You can use it to briefly describe 

the purpose for protecting this resource.
1c Select the contract that uses the FilrAuth method.
1d In the URL Path List, add the following paths for HTML content:

/*
/ssf/*

1e Click OK.
2 Create a public protected resource for Web Services:

2a In the Protected Resource List, click New. Specify public for the name, then click OK.
2b (Optional) Specify a description for the protected resource. You can use it to briefly describe 

the purpose for protecting this resource.
2c For the Contract, select None.
2d Click OK.
2e In the URL Path List, remove the /* path and add the following paths for public content:

/ssf/atom/*
/ssf/ical/*
/ssf/ws/*
/ssf/rss/*
/ssr/* 
/rest/*
/
/dave/*
/my_files/*
/net_folders/*
/shared_with_me
/desktopapp/*
/ssf/e/*
/ssf/static/*
/ssf/gwt/*
/ssf/s/*
/ssf/s/readFile/share/*
/ssf/applets/*

2f Click OK.
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3 Assign the X-Forwarded-Proto Header policy to both protected resources that you created: 
3a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] > 

Protected Resources.
3b For each Filr protected resource, click the Identity Injection link, select the x-forwarded 

policy that you created, click Enable, then click OK.
3c Click OK.

4 Assign the Identity Injection policy to the HTML protected resource that you created.
4a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] > 

Protected Resources.
4b For each Filr protected resource, click the Identity Injection link, select the ldap_auth policy 

that you created, click Enable, then click OK.
4c Click OK.

5 In the Protected Resource List, ensure that the protected resources that you created are 
enabled.

6 To apply your changes, click Devices > Access Gateways, then click Update All.

Configuring a Rewriter Profile
1 Click Devices > Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] 

> HTML Rewriting.
2 In HTML Rewriter Profile List, click New.
3 Specify a name for the profile, select Word as the search boundary, then click OK.
4 In the And Document Content-Type Header Is section, click New, then specify the following type:

application/rss+xml
5 In the Variable or Attribute Name to Search for Is section, click New, then specify the following 

as the variable to search for:

value
6 Click OK.
7 In the Protected Resource List, ensure that the protected resources you created are enabled. 
8 To apply your changes, click Devices > Access Gateways, then click Update All.
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B BAll-in-One (Small) Deployment—
Creating

To create an all-in-one deployment, you install one Filr appliance. By default Filr also includes the 
MySQL database and Filrsearch functions.

Ensuring All-in-One Suitability
With few exceptions, small deployments are only suitable for proof-of-concept deployments, which, 
by definition, do not require extensive planning.

For a production deployment, you should use the Filr 3.4 Planning Your Filr Deployment—Best 
Practices guide and associated planning worksheets to gauge whether a small deployment could 
meet your organization’s production needs. 

The Micro Focus best practice recommendation is always an expandable deployment, which is the 
focus of this guide.

All-in-One System Requirements
Most of the requirements in Chapter 3, “System Requirements,” on page 13 apply to small 
deployments. 

However, minimum RAM and CPU recommendations are increased to handle the database and 
search functions running in addition to Filr.

 12 GB of RAM (16 GB is recommended) 
 4 CPUs. 

80% of the RAM should be dedicated to the Java heap.

For information about adjusting the Java heap settings, see “Changing JVM Configuration Settings” 
in the Filr 3.4.1: Administrative UI Reference.

All-in-One Deployment
To deploy an all-in-one Filr appliance, complete the instructions in the following sections:

Table B-1   

Section Additional Information

Chapter 5, “Downloading and Preparing the Filr 
Software,” on page 27

You only need to download the Filr software for your 
virtualization platform.

Chapter 6, “Deploying the Virtual Machines,” on 
page 31

Follow the instructions in the section for your 
virtualization platform.

Chapter 7, “Starting and Configuring the Appliances,” 
on page 45

Follow the instructions in the referenced section, then 
continue with
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Setting Up an All-in-One (small) Filr Appliance

Table B-2   Logging in and Setting Up a Small Filr Appliance

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 9443 Administration Utility on the Filr appliance using the following 
URL:

https://filr_IP_Address:9443

Where IP_Address is the IP address of the Filr appliance.

Filr Appliance Sign In 1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 47.

Filr Appliance Tools
1. Click the Configuration icon  to launch the Filr Configuration Wizard. 

Filr Configuration Wizard 1. Click Next. 

Database 1. Type and confirm a password for the filr user in the MySQL database.

Default Locale 1. Select your Locale from the dropdown list.

2. Change the Administrator User ID if you want to.

The User ID that you enter is also the password for the initial login for the Port 
8443 administration console. 

3. Click Finish.

4. Do not close or exit the browser page until the warning message disappears. 
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C CMySQL Appliance—Configuring  
(Alternate Practice)

Figure 8-3 illustrates that the MySQL appliance is configured to recognize the Filr appliances and 
allow them to connect before they are set up and deployed.

Figure C-1   Deploying MySQL

Table C-1   Configuring a MySQL Appliance

Page or Dialog Do This

IMPORTANT: The following steps assume that you installed and prepared a MySQL 
appliance as documented in the previous chapters, in addition to your Filr and 
Filrsearch appliances.

1. Using a browser on your management workstation, access the Port 9443 
Administration Utility on the MySQL appliance by entering the following URL:

https://mysql_IP_Address:9443

Where IP_Address is the IP address of the MySQL appliance.

Filr 3

Filr 2

 Filr 1

SQL Database MySQL
Appliance

Filr Search 2

Filr Search 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Prepare the MySQL Appliance
(Alternate Practice)

.gz.zip Or

download.novell.com
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MySQL Appliance Sign 
In

1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 47.

MySQL Tools 1. Click the phpMyAdmin button to launch the phpMyAdmin utility.

2. Log in as root with password root.

phpMyAdmin 1. Under General Settings, click Change Password.

2. Type and retype (confirm) a new password for the phpMyAdmin root user, 
then click Go.

IMPORTANT: If you click the Generate button, the generated password takes 
precedence over your typed passwords. 

Be sure to note the generated password and use it when configuring Filr. 

3. Click the Users tab.

Users Overview 1. Under New, click Add User.

Login Information 1. Type filr in the User Name field.

TIP: You can specify any name for the user and associated database. If you 
specify a different name, then when you set up the Filr appliances, you will 
need to use that name instead of filr.

2. For the Host field, select Use Host Table.

3. In the Host field, type the IP addresses for each of the Filr appliances that you 
will configure.

4. In the Password and Re-type fields, type and re-type (confirm) a password for 
the new filr user, then scroll down. 

IMPORTANT: You will need this password when you configure the Filr 
appliances.

Database for user 1. Select Create database with same name and grant all privileges.

2. In the bottom right corner of the dialog, click Go.

A filr user entry is added and the corresponding database is created.

Users Overview 1. Notice that the filr user is listed with the appliances’ IP addresses shown in the 
Host column.

2. Return to “Setting Up the Filr Appliances” on page 57.

Page or Dialog Do This
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D DNon-Expandable Deployment—
Creating

The steps required to create a non-expandable Filr deployment are almost identical to those for an 
expandable deployment.

Do the following:

1. Begin with Chapter 2, “Planning Is Critical,” on page 11 and complete all of the instructions that 
apply to your virtualization platform and plans.

2. Skip Chapter 4, “Setting Up Shared Storage,” on page 23.
3. Follow the instructions in the remaining sections as they apply.
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E EOES 2015 NSS AD as a Net Folder 
Server 

Although both Filr 3.0 and OES 2015 NSS AD support SMB v2, Filr configures Net Folder 
connections that point to NSS AD servers to use the SMB v1 protocol.

If you have Net Folder Server connections that point to NSS AD servers, you should change Filr to 
use SMB v2 for the connections by doing the following:

1 Ensure that the OES 2015 NSS AD server has the latest patches applied. 
2 If SSH is not enabled on the Filr appliance, do the following:

2a Log in to the Filr appliance at https://server_url:9443 as the vaadmin user.
2b Click System Services, then click SSH > Action > Start.

3 Using an SSH client, log in to the Filr appliance as the root user.
4 Run the following command:

/opt/novell/filr/bin/famtconfig -s ncifsSMB 2
5 Restart famtd by running the following command. 

# rcnovell-famtd restart

IMPORTANT: If you do not restart famtd, then the SMB v1 protocol is used for connections 
made prior to doing Step 4.

6 For large, clustered deployments, repeat these steps for all of the Filr servers in the cluster

NOTE: To reset the Filr connections with OES 2015 NSS AD servers from SMB v2 back to SMB v1, 
run the following commands:

/opt/novell/filr/bin/famtconfig -s ncifsSMB 1
# rcnovell-famtd restart
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F FSCSI Controller Type—Changing on 
VMware

To change the SCSI controller type on a VMware-based appliance to VMware Paravirtual: 

1. Finish the installation and power on the Filr system. 
2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, and log in 

as that user.)
3. Shut down each appliance in the Filr system. (For information about how to safely shut down an 

appliance, see “Shutting Down and Restarting the Micro Focus Appliance” in the Filr 3.4.1: 
Administrative UI Reference.)

4. In VMware, change the controller to VMware Paravirtual.
5. Power on each appliance in the Filr system.
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G GTroubleshooting the Filr Installation 
and Upgrade

 “Failure to Update to Filr 3.4” on page 139
 “Unable to Access a Newly Installed Appliance” on page 139
 “The Upgrade Dialog Box Is Not Displayed during an Upgrade” on page 140
 “Rolling Back to the Previous Version after an Unsuccessful Upgrade” on page 140

Failure to Update to Filr 3.4 
Updating to Filr 3.4 may fail with the following error:

One of the reason for failure could be MySQL or Filr Search is down. You can refer to the logs at /
filrinstall/post_update.log for more information. 

Resolve the issues with MySQL or Filr Search, then do the following: 

1 Log in to the Filr Appliance Configuration Console (https://appliance_ip_or_dns:9443) as 
vaadmin.

2 Click Online Update.
3 In the Needed Patches, even though no patches are available, click Update Now.

This is an important step and will ensure to update the patch successfully. 

Unable to Access a Newly Installed Appliance
If you are unable to access a newly installed appliance and you need to change appliance settings, 
such as the IP address, use the VACONFIG utility from the Filr command prompt. 

For more information, see “Using VACONFIG to Modify Network Information” in the Filr 3.4: 
Maintenance Best Practices Guide.
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The Upgrade Dialog Box Is Not Displayed during an 
Upgrade

The following dialog box should be displayed when powering on the new appliance.

If it is not displayed, the data storage location was not successfully copied or attached to the new Filr 
system. Begin the upgrade process again and ensure that you have configured the new Filr system to 
point to the data storage location of the source Filr system.

Rolling Back to the Previous Version after an 
Unsuccessful Upgrade

You can roll the Filr system back to the previous version if the upgrade is unsuccessful.

 “Rolling Back a Small or Non-Clustered Filr System” on page 140
 “Rolling Back a Clustered Filr System” on page 140

Rolling Back a Small or Non-Clustered Filr System
You should have created a copy of the data storage location (/vastorage) to be used in the new Filr 
system (as described in “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80).

If you experience complications when upgrading the Filr system, your existing Filr system is still intact 
and you are able to power it on at any time. 

Rolling Back a Clustered Filr System
A clustered Filr system (multiple Filr appliances) consists of not only a data storage location (/
vastorage), but also shared storage (/vashare).

 “Rolling Back the Data Storage Location (/vastorage)” on page 141
 “Rolling Back the Shared Storage Location (/vashare)” on page 141
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Rolling Back the Data Storage Location (/vastorage)
You should have created a copy of the data storage location (/vastorage) to be used in the new Filr 
system (as described in “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 80).

If you experience complications when upgrading the Filr system, the data storage location of your 
existing Filr system is still intact.

Rolling Back the Shared Storage Location (/vashare)
After an unsuccessful upgrade, you can roll back the shared storage location (/vashare) to the 
previous version by reconfiguring clustering on the Filr server:

1 On the Filr appliance that you are rolling back to, log in as the Filr administrator.
https://ip_address:9443
Replace ip_address with the IP address of your Filr appliance.

2 Sign in to the Filr appliance using the vaadmin user and the password that you set during 
installation.
The Micro Focus Filr Appliance landing page is displayed.

3 Click the Filr Server Configuration  icon. 
4 Click Clustering.
5 In the Server Address field, add the port number to the server address of each search index 

appliance.
For example, change 172.17.2.2 to 172.17.2.2:11211
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H HThird-Party Materials

 “Growl License” on page 143
 “Oracle Outside In Technology” on page 144
 “ANTLR 3 License” on page 144
 “Colt License Agreement” on page 145
 “Dom4j License” on page 145
 “iCal4j License” on page 146
 “ICU4J license (ICU4J 1.3.1 and later)” on page 146
 “JAXEN License” on page 147
 “Jung” on page 147
 “ASM” on page 148
 “Firebug Lite” on page 149

Growl License
Copyright (c) The Growl Project, 2004-2011

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of Growl nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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Oracle Outside In Technology
Oracle shall inform you of any notices and other instructions that are related to third party 
components (including open source software) that are included in a program and/or hardware and 
that Oracle is required to distribute with such programs and/or hardware. These notices and other 
instructions shall be provided to you in at least one of the following ways, at Oracle’s sole discretion: 
(a) automatically installed with the programs or in the installation details; (b) in the program 
documentation; (c) in the readme files or notice files; or (d) via a supplemental list. You shall comply 
with all instructions related to third party software components (including open source software). If 
you reproduce the programs, operating system and/or integrated software, you shall reproduce all 
third party notices in an appropriate location in the reproduction and/or in its related documentation 
and include any associated source code (to the extent such source code is provided by Oracle), as 
required by the applicable notices or as otherwise directed by Oracle?.

PDF documents with complete information about the use of Oracle technology in Filr are located in 
the following directory on the Filr server:

/opt/novell/filr/stellent-converter

ANTLR 3 License
Copyright (c) 2003-2008, Terence Parr

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of the author nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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Colt License Agreement
Packages cern.colt*, cern.jet*, cern.clhep 

Copyright (c) 1999 CERN - European Organization for Nuclear Research.
Permission to use, copy, modify, distribute and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear in supporting 
documentation. CERN makes no representations about the suitability of this software for any 
purpose. It is provided “as is” without expressed or implied warranty. 

Packages hep.aida.* 
Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas 
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or 
redistribute this work is granted under the terms of the LGPL License, with the exception that any 
usage related to military applications is expressly forbidden. The software and documentation 
made available under the terms of this license are provided with no warranty.

Dom4j License
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without 
modification, are permitted provided that the following conditions are met: 

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions 
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

3. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com. 

5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in 
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark 
of MetaStuff, Ltd. 

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS”' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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iCal4j License
Copyright (c) 2008, Ben Fortuna

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of Ben Fortuna nor the names of any other contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

ICU4J license (ICU4J 1.3.1 and later)
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2001 International Business Machines Corporation and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the 
Software, and to permit persons to whom the Software is furnished to do so, provided that the above 
copyright notice(s) and this permission notice appear in all copies of the Software and that both the 
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. 
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE 
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR 
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, 
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 

JAXEN License
Copyright (C) 2000-2002 Bob McWhirter & James Strachan.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and 
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, 
and the disclaimer that follows these conditions in the documentation and/or other materials 
provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their 
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided 
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen 
AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen 
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan 
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
www.jaxen.org.

Jung
THE JUNG LICENSE

Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the University of California nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM
Copyright (c) 2000-2005, INRIA, France Telecom

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Firebug Lite
Copyright (c) 2006-2007, Joe Hewitt

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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